Planning and Installation Guide

Reflection X Advantage

Version 4.2

Attachmate
## Contents

### Welcome to Reflection X Advantage
- Operating Modes: Domain vs. Standalone  
  
### Installation and Migration
- System Requirements  
- Install Reflection X Advantage on Windows  
  - File Location Tab  
  - Feature Selection Tab  
  - Installer Advanced Tab  
- Install on UNIX  
- Install on a Mac  
- Which Reflection X Advantage Features Should I install?  
- Upgrade and Migration  
  - Which Version Am I Running?  
  - Upgrading from Earlier Versions of Reflection X Advantage  
  - Upgrading from Legacy Reflection X  
  - Feature Guide for Upgrading from Legacy Reflection X  
  - Migrating Settings From Hummingbird Exceed  
- Uninstall Reflection X Advantage  
  - Remove All Reflection X Files  

### Getting Started
- Use XDMCP to access your host desktop  
- Run an X Client Application on your Windows Desktop  
- The X Manager Interface  
- Reflection X Icons  
- Understanding Session Definitions  
- Frequently Asked Questions  

### Understanding Session Distribution
- Reflection X Session Processes  
- X Manager Basic Session  
- X Manager Distributed Session  
- Reflection X Domain Components  
- X Manager for Domains Basic Session  
- X Manager for Domains Distributed Session
Using Reflection X Domains 45

Setting up Domain Components 45
Set Up the Domain Controller 45
Start and Stop the Reflection X Service 46
Set Up an Administrator Workstation 47
Set Up Domain Nodes 48
Remove a Domain Node 49
Set Up User Workstations 50
Manage Session Persistence and Performance 51

Domain Authentication 52
How Domain Access is Controlled 52
Configure and Test User Authentication 53
Set Up LDAP Authentication 54
Set Up Reflection X Internal Authentication 55
Add or Remove Domain Users 55
Unlock a Domain 56

Sample Domain Configurations 57
Domain Setup: Improve Performance Over a Slow Network 57
Domain Setup: Leave a Session and Rejoin from a Different Computer 60
Domain Setup: Centralize Session Configuration 63

Customizing and Distributing Reflection X 67

Deploying with the Windows Installer 69
Performing a Basic Deployment 70
Install from the Command Line 70
Performing an Advanced Deployment 71
Create an Administrative Installation Point 72
Attachmate Customization Tool 73
Creating and Editing Transforms 74
Creating a Companion Install Package 80
Deploying Reflection X 83

Distributing Sessions with the Administrative WebStation 85
Configure Sessions using the Administrative WebStation 85
The Reflection for the Web Security Proxy 87
Administrative WebStation Mode 87
WebStation User Mode 88
Save Settings (Administrative WebStation Mode) 88
Discard Settings (WebStation User Mode) 88
Welcome to Reflection X Advantage

Reflection X Advantage is an X server that allows you to view your UNIX desktop and work with X client applications from a remote workstation. Reflection X Advantage provides two modes of operation—Standalone and Domain mode.

Standalone mode is provided by a single application—X Manager, which is installed by default. For users of earlier Reflection X products, Reflection X Advantage in standalone mode will be familiar territory: a bulletproof X server that provides reliable, seamless access to your mission-critical X applications.

Domain mode offers all the functionality of standalone mode and complements that power with additional features that help enhance productivity without increasing costs. Domain mode consists of multiple components—X Manager for Domains, the X Administrative Console, and the Reflection X Service. These features are not installed by default; and different systems within the domain require different components.

Whichever mode you choose, you'll have access to the following features:

- **Multiple platform support**: Using Reflection X Advantage, users can access X hosts and applications from a broader-than-ever array of desktop environments, including Windows 7, Vista, and XP; Linux; Solaris; HP-UX; and Mac.

- **Real-time collaboration**: The session sharing and transfer features in Reflection X Advantage allow colleagues to look at the same applications concurrently, and even transfer control of the session from one user to another.

- **Improved performance options**: Using Reflection X Advantage, you can address problems with low bandwidth or high latency connections using remote session services. When you configure distributed Reflection X sessions, only the protocol required to update the display is sent over the network. This results in dramatically improved performance where high latency is a problem. Where low bandwidth is a problem, Reflection X automatically compresses the protocol sent to remote X servers.

- **Fully-integrated Secure Shell with FIPS 140-2 validation support**: With Reflection X Advantage, you get a single-vendor security solution that is integrated with the X server.

- **X11 Extension Support**: Reflection X Advantage provides support for key X11 extensions including GLX, Render, Damage, Shape, and XFixes.

- **Native IME support for input of double-byte characters**: Native IME support lets you use your workstation's input method editor (IME) to compose characters (including Japanese, Korean, and Chinese). The X11 Input Method (XIM) server provided by Reflection X obtains the composed text from your IME and passes it to XIM-aware clients. This means that you can work with varied X clients without having to learn new input techniques.

- **X.509 certificate authentication**: Secure Shell connections require both user and host authentication. In addition to supporting standard options for user authentication (passwords and public keys), Reflection X also supports authentication using X.509 certificates. Certificates can be stored in the Reflection X Advantage Store, a local directory, the Windows Certificate Store, or on a Smart card or similar device. Also, by downloading and installing Reflection PKI Services Manager you can configure Reflection X to authenticate hosts that present X.509 certificates. Reflection PKI Services Manager is available at no additional charge.
Additional features available in Domain mode include:

- **Centralized session configuration:** Reflection X domain features can help simplify session setup for end users. Administrators can create and maintain sessions in a single centralized location and provide users with access to these sessions. Users can get started quickly using these centrally configured sessions, and can also create and configure individual sessions on their own workstations.

- **Flexible, instant access to an established session from the office, at home, or on the road:** Leave a running session from one location and rejoin the same session from another location. No time is spent on reestablishing the client connection.

- **Session protection:** When you leave a session running, you can use fault tolerance to safeguard against losing the session. This option enables you to return to your work exactly where you left it, even after a network or hardware failure.

- **Domain authentication services:** Leverage your current authentication process to provide Reflection X Advantage domain authentication. Use any of these authentication methods: Windows, PAM (Pluggable Authentication Modules), LDAP (Lightweight Directory Access Protocol), and Reflection X Internal.

- **Load balancing:** In a distributed session environment, Reflection X Advantage is installed on more than one computer, and sessions can run on multiple domain nodes. When a user initiates a session, the session is run on the least-loaded domain node.

---

**Operating Modes: Domain vs. Standalone**

Reflection X can be operated in either "Standalone" or "Domain" mode.

**Standalone mode**

Standalone mode is provided by a single application—X Manager, which is installed by default. In this mode you use one application, **X Manager** to access X hosts and clients, configure and share sessions, and monitor session status — all from your own desktop. For a quick introduction to session configuration, see Getting Started (page 27).

**Domain mode**

Running Reflection X in Domain mode provides access to all the features in standalone mode, and also provides access to additional domain services. Domain administrators run the **X Administrative Console** to configure and manage Reflection X domains; and handle load balancing, optimizing performance for a group of X sessions. Domain users run **X Manager for Domains** to access X hosts and clients. These applications connect to a central domain controller, which runs the Reflection X service and stores session definitions in a shared database. As an authorized domain user, you can start, join, leave, and share a running X session. You can use all public definitions created by administrators, as well as create private definitions available only to you. For information on setting up and configuring a Reflection X domain, see Using Reflection X Domains (page 45).
# Feature comparison

<table>
<thead>
<tr>
<th>Feature</th>
<th>Standalone Mode (X Manager)</th>
<th>Domain Mode (X Manager for Domains)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Launch and interact with an X client application</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>XDMCP</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>X session sharing</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>X11 Extensions support</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Improved performance over slow networks</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Integrated Secure Shell</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>FIPS 140-2 support</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>X.509 certificate authentication</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Centralized configuration of X sessions</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Leave and rejoin X sessions</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Fault tolerance for X sessions</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>
Chapter 2

Installation and Migration

In this Chapter

System Requirements 11
Install Reflection X Advantage on Windows 11
Install on UNIX 14
Install on a Mac 15
Which Reflection X Advantage Features Should I install? 16
Upgrade and Migration 17
Uninstall Reflection X Advantage 24

System Requirements

System requirements information is available from the Attachmate Technical Library.

- For information about supported platforms and additional system requirements, see Technical Note 2632 (http://support.attachmate.com/techdocs/2632.html).
- For updates about security issues related to Reflection X Advantage, see Technical Note 2505 (http://support.attachmate.com/techdocs/2505.html).

Install Reflection X Advantage on Windows

Reflection X Advantage is included as a component in Reflection X 2011 and Reflection Suite for X 2011.

The following applications are installed by default:

- X Manager
  Provides complete support for connecting to X clients in standalone mode.

- Reflection Workspace
  Provides access to VT terminal sessions. With the Suite for X, IBM terminal and printer support are also included.

- Reflection FTP Client
  Supports file transfer using both FTP and SFTP protocols.

If you are planning on running Reflection X Advantage in domain mode, you will need to install additional features on the computers running in your domain. These features are not installed by default. For a summary of some typical installation configurations for domain mode, see Which Reflection X Advantage Features Should I install? (page 16) For more detailed information, see Setting up Domain Components (page 45).
To install on Windows

1 Log on using a Windows account with administrator privileges.

2 Start the Attachmate Installation Program (Setup.exe). If you are installing from the download site, the following steps start this program:
   a) From the download site, click the Windows download link and run the download program.
   b) Select a location for the installer files, and then click Next. This extracts the files to the specified location and starts the Attachmate Installation Program.

3 The installer checks your system for required software prerequisites. If these are not present, the installer installs these packages before running the product installation.

4 To view and/or modify which features are installed, click the Feature Selection tab (page 13).

Notes:

- For information about viewing the install log, see Installer Advanced Tab (page 13).
- An Administrative installation doesn’t install the product to your workstation. It copies files to an administrative installation point. This network location can be used by deployment tools to access and create packages that are deployed to workstations. End users can perform workstation installations by running setup.exe from this location.
- A 64-bit installer is available for installing Reflection X 2011 and Reflection Suite for X 2011 on 64-bit Windows platforms. This installer includes 64-bit Reflection X Advantage and 32-bit Reflection Workspace and Reflection FTP client. (The 32-bit applications are supported on 64-bit platforms.) Legacy Reflection X is not included with the 64-bit installer.

File Location Tab

You can use the installer’s File Location tab to specify a location for the program files.

Notes:

- If you are installing Reflection X 2011 and Reflection Suite for X 2011, you will see an option to change the Default user data directory. This value applies to the Reflection Workspace, legacy Reflection X, and the Reflection FTP Client; it has no effect on the location used for Reflection X Advantage data files.
- The 64-bit installer for Reflection X 2011 and Reflection Suite for X 2011 includes both 32-bit and 64-bit components. To change the program file location, specify a location for both 32-bit and 64-bit program files. You can specify the same location or different locations.
Feature Selection Tab

Use the Feature Selection tab select how you want to install product features.

To select features, components, and languages to install

1. For each item, select from the options below.

<table>
<thead>
<tr>
<th>Choose</th>
<th>To do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>□ Feature will be installed on local hard drive</td>
<td>Install an item.</td>
</tr>
<tr>
<td>□ Feature will be installed when required</td>
<td>Advertise an item. For example, you can select a component from the Start menu, and it will install at that time.</td>
</tr>
<tr>
<td>✗ Feature will be unavailable</td>
<td>Leave an item uninstalled. You will still be able to install the item later using the Windows Programs and Features (or Add/Remove Programs) control panel.</td>
</tr>
</tbody>
</table>

Installer Advanced Tab

Getting there

1. Run the Attachmate Installation Program (setup.exe).
2. Click the Advanced tab.

The options are:

<table>
<thead>
<tr>
<th>Install to this PC</th>
<th>Installs Reflection X to your computer.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create an Administrative Install image on a server</td>
<td>Note: An administrative installation does not actually install the product — instead, it creates an installation image that you can use to deploy Reflection X to end users. When you create an administrative installation image, an image of Reflection X is copied to a network location for later installation to multiple workstations. This network location can be used by deployment tools to access and create packages that are deployed to workstations. Also, end users can perform installations by running setup.exe from this location.</td>
</tr>
<tr>
<td>Log file settings</td>
<td>By default an installation log file is created, but this file is deleted if the installation succeeds. (This configuration avoids accumulation of large log files after successful installations.) To save a log file for all installations, including successful ones, select Create a log file for this installation, and clear Delete log file if install succeeds. The installation log file, which provides details about the installation, is saved in the user’s temp directory (%tmp%) with a generated name that begins with atm. To open this folder, launch the Start menu Run command and enter %tmp%.</td>
</tr>
</tbody>
</table>
Install on UNIX

X Manager is installed by default. This application provides complete support for connecting to X clients in standalone mode. If you are planning on running Reflection X Advantage in domain mode, you will need to install additional features on the computers running in your domain. These features are not installed by default. For a summary of some typical installation configurations for domain mode, see Which Reflection X Advantage Features Should I Install? (page 16) For more detailed information, see Setting up Domain Components (page 45).

Note: UNIX installers do not include the emulators and FTP Client, which are only available when you install on Windows.

To install Reflection X Advantage on UNIX systems

1. Download the installation package for your UNIX operating system from the download site.

   Note: The download files (*.zip) for each supported UNIX system include both 32-bit and 64-bit installers if both platforms are available.

2. Unzip the download file; for example:

   ```
   unzip -d rx-advantage-4.0.0.999-prod-linux.zip
   ```

   The expanded download file contains binary files (*.bin) for installing on different platforms. Locate the appropriate file for your UNIX platform.

   Note: For additional information about using zip utilities to expand .zip UNIX packages, refer to Technical Note 1925 (http://support.attachmate.com/techdocs/1925.html).

3. If you unzipped on a Windows computer, copy the installation file for your platform to your UNIX computer.

4. Log on as root and navigate to the directory that contains the installation file.

5. Change the permissions of the installation package to give execute permissions to the file owner. For example:

   ```
   chmod 744 rxa-4.0.0.999-prod-i586-linux.bin
   ```

6. Start the installation program. For example:

   ```
   ./rxa-4.0.0.999-prod-i586-linux.bin
   ```

   Note: The command above launches the InstallAnywhere installation program which requires an X11 Windows display. To initiate a command line installation, you can add the parameters -i console. For example:

   ```
   ./rxa-4.0.0.999-prod-i586-linux.bin -i console
   ```
You can modify the feature selections during the install. X Manager is installed by default.

Note: If you are using the -i console option, you'll have an opportunity to specify which features you want to install by entering a comma-separated list in response to the prompt: "Please choose the Features to be installed by this installer:" To install all features, you can type 1,1.

Note: On UNIX systems, an install log is created here:
/opt/rxadvantage/Attachmate_Reflection_X_Advantage_InstallLog.log.

Install on a Mac

X Manager is installed by default. This application provides complete support for connecting to X clients in standalone mode. If you are planning on running Reflection X Advantage in domain mode, you will need to install additional features on the computers running in your domain. These features are not installed by default. For a summary of some typical installation configurations for domain mode, see Which Reflection X Advantage Features Should I Install? (page 16) For more detailed information, see Setting up Domain Components (page 45).

Note: The Mac installer does not include the emulators and FTP Client, which are only available when you install on Windows.

To install Reflection X Advantage on a Mac

1. Download the installation file (*.dmg) to your Mac.

2. Double-click the installation file.
   This opens a Finder window that contains an installer metapackage file (*.pkg) and a documentation folder.

3. Double-click the metapackage file to start the installation.

4. To view and/or modify which features are installed, from the Installation Type step, click the Customize button.

Note: On the Mac, an install log is created here: /var/log/install.log.
Which Reflection X Advantage Features Should I install?

X Manager (standalone) is installed by default. If you plan on configuring a Reflection X domain, you need to install additional features. The following table summarizes some typical installation configurations.

Note: You can install and use any combination of Reflection X Advantage features on a single computer. The following table provides guidelines, but you are not limited to these configurations. For example, you may want to install and run both X Manager (standalone) and X Manager for Domains on the same computer.

<table>
<thead>
<tr>
<th>Standalone mode</th>
<th>Install these features</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standalone user workstation</td>
<td>X Manager</td>
</tr>
<tr>
<td>Remote session service node</td>
<td>Remote Session Services</td>
</tr>
<tr>
<td>(available on UNIX installs only)</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Domain mode</th>
<th>Install these features</th>
</tr>
</thead>
<tbody>
<tr>
<td>Domain user workstation</td>
<td>X Manager for Domains</td>
</tr>
<tr>
<td>Domain administrator's workstation</td>
<td>X Manager for Domains</td>
</tr>
<tr>
<td></td>
<td>X Administrative Console</td>
</tr>
<tr>
<td>Domain controller</td>
<td>X Administrative Console</td>
</tr>
<tr>
<td></td>
<td>Domain Services</td>
</tr>
<tr>
<td></td>
<td>Domain Controller</td>
</tr>
<tr>
<td>Domain node</td>
<td>Domain Services</td>
</tr>
<tr>
<td></td>
<td>(without the domain controller)</td>
</tr>
</tbody>
</table>
Upgrade and Migration

Which Version Am I Running?

On Windows, Reflection X Advantage is installed as a feature with Reflection X 2011 and Reflection Suite for X 2011, as shown in the table below.

Note: You can find version information for both Reflection X Advantage and the product it was installed with using Help > About from X Manager or X Manager for Domains.

<table>
<thead>
<tr>
<th>Installer version</th>
<th>Reflection X Advantage version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reflection 2011 R3</td>
<td>Reflection X Advantage 4.2</td>
</tr>
<tr>
<td>Reflection 2011 R2 SP1</td>
<td>Reflection X Advantage 4.1</td>
</tr>
<tr>
<td>Reflection 2011 R2</td>
<td>Reflection X Advantage 4.0</td>
</tr>
<tr>
<td>Reflection 2011 R1</td>
<td>Reflection X Advantage 3.0</td>
</tr>
</tbody>
</table>

Upgrading from Earlier Versions of Reflection X Advantage

If you are upgrading from an earlier version of Reflection X Advantage (or any product that includes Reflection X Advantage as a feature), note the following:

- You can run the new installer with an installed version in place. The earlier version is uninstalled as part of the installation process. Your database files remain in place.

- Your database files are upgraded automatically to the current version the first time Reflection X Advantage is started.

- Support for running different versions of Reflection X together is available for Reflection X Advantage domains (see below). This feature is not supported for distributed sessions that use the standalone X Manager. If you use the Remote session services feature with the standalone X Manager, you need to upgrade all components at the same time.

Upgrade notes for Reflection X domains

Upgrading domains running version 4.0 or earlier

Prior to version 4.1, all computers in a Reflection X Advantage domain need to run the same version. This is true for service packs as well as major releases.

- If you installed 4.0 or earlier, you need to upgrade all computers in the domain at the same time when you upgrade to version 4.1 or later.
Upgrading domains running version 4.1 or later

Starting with version 4.1, you can update Reflection X Advantage domain components individually before you update your domain controller. If your domain components are running version 4.1 or later, review the following information before upgrading:

- You can install a newer version of Reflection X Advantage on systems running X Manager for Domains, the X Administrative Console, and domain nodes. These components will be able to connect to your (older) domain controller and will run using the Reflection X version of that domain controller. This means that features or bug fixes from the newer version will not yet be supported.

  Note: Go to Help > About for version information. The information displayed always shows the currently installed version. If you are connected to an older domain controller, the display also shows the current running version.

- You can upgrade your domain controller after all other computers in the Reflection X domain have been upgraded. After the domain controller is upgraded, all domain components will run using the newer version; at this time the latest features and bug fixes will be available to all domain components.

Adding domain nodes with version 4.0 or later

Starting with version 4.0, you can no longer add domain nodes using the X Administrative Console. You must now log in as an administrator on each computer that you want to add as a domain node and use the rxsconfig command line utility to add the computer to the domain. (This utility is installed when you install version 4.0 and include the Domain Services feature.) This requirement ensures that only users with administrator (or root) privileges on a computer can add that computer to a Reflection X domain.

- Domain nodes registered prior to 4.0 are removed when you upgrade to 4.0. You'll need to rejoin these nodes to your domain using rxsconfig. For instructions, see Set Up Domain Nodes. (page 48)

Upgrading from Legacy Reflection X

You can install Reflection X Advantage on systems that have legacy Reflection X products (v. 13 or 14). The first time you start Reflection X Advantage, you'll see a prompt asking if you want to import your settings. Click Migrate to import your settings. (If you cancel, you can still import your settings later.) Your legacy Reflection X files are not changed.

Imported settings appear as a combination of session, client, and server definitions identified as "(RX migrated)" in X Manager. Use either of the following approaches to connect using these migrated settings. For information about where to find settings in the new X Manager, see Feature Guide for Upgrading from Legacy Reflection (page 20).

To connect by starting a new session for each migrated client

1. Under Sessions, locate the session definition based on the client you want to start, for example:

   myclient session (RX migrated)

2. Double-click the session definition (or right-click and select Start).
To connect by attaching multiple clients to a single session

Use this approach if you used more than one server instance with your legacy Reflection X client connections. You may also want to use this approach if you typically run many X clients simultaneously.

1. Under **Sessions**, locate the session name based on a migrated server name (the default legacy Reflection X server is called config). For example:

   config session (RX migrated)

2. Double click the session definition (or right-click and select **Start**).

   Note: You won't see a client yet. This step starts an X server, but doesn't launch any clients yet. Legacy Reflection X starts a default server instance automatically. With Reflection X Advantage, you use sessions to start server instances.

3. Under **Clients**, locate the migrated client definition for example:

   myclient (RX migrated)

4. Double click the client definition (or right-click and select **Start**).

   Note: You can easily modify any session to start multiple clients automatically. To do this, select your session definition, set **On session start/reset** to **Start X clients**, then click the plus sign (+) next to **X Clients**.

Migrated Settings Definition Files

Legacy Reflection X stores client settings in client files (*.rcx files) and stores X server settings in the Windows registry. Reflection X Advantage stores all settings in a database. The Reflection X Advantage migration tool creates a definition file (page 99) with your migrated client and server settings. When you click **Migrate**, the settings in this definition file are imported into the Reflection X Advantage database and show up in Reflection X Advantage as migrated session, client, and server definitions.

Note: If you choose not to import the settings when you first start X Manager or X Manager for Domains, you can import the migrated settings at a later time. Using this option gives you an opportunity to explore the default configuration before you import your migrated settings.

Use the following procedure if you decide to wait and import settings at a later time:

**To import migrated settings from a definition file:**

1. From X Manager or X Manager for Domains, click **File > Import**.

2. Browse to your Windows user profile folder to locate the definition file that contains your migrated settings. The definition file name identifies the product and version whose settings were migrated. For example: Reflection X 14_0_7.rxd

   On Windows XP, the default location is: \Documents and Settings\<user>\attachmate\rx\migration\
On Windows 7 and Windows Vista, the default location is:
\Users\<user>\Documents\attachmate\rx\migration\\n
3  In the **Import Definitions** dialog box, click to select all the definitions.

4  Click **Import**.

---

**Feature Guide for Upgrading from Legacy Reflection X**

If you are upgrading from older Reflection X products (version 13 or 14), you’ll find that the X Manager user interface in Reflection X Advantage includes many of the same capabilities, and certain features work differently than they previously did.

Use the following table to determine where features are located in the new X Manager provided with Reflection X Advantage.

<table>
<thead>
<tr>
<th>Name in Reflection X version 14.x</th>
<th>Name/location in Reflection X Advantage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client file (.rcx)</td>
<td>Client definition (page 99)</td>
</tr>
<tr>
<td><em>Client templates</em></td>
<td>The function formerly provided by individual client templates is handled by interactive fields in the <strong>Client Definition</strong> pane, and by public client definitions (page 102) created by the administrator.</td>
</tr>
<tr>
<td><em>Client connection settings</em></td>
<td><strong>Client Definition</strong> pane</td>
</tr>
<tr>
<td>such as Method, Host name, User name, Password, and Command</td>
<td></td>
</tr>
<tr>
<td><em>Advanced Client Connection Settings</em></td>
<td></td>
</tr>
<tr>
<td>Never close client starter connection</td>
<td><strong>Client Definition</strong> &gt; <strong>Advanced</strong> button &gt; <strong>Never close connection</strong></td>
</tr>
<tr>
<td>Secure Shell options</td>
<td><strong>Client Definition</strong> &gt; <strong>Advanced</strong> button &gt; <strong>General</strong>, <strong>Encryption</strong>, and <strong>Authentication</strong> tabs</td>
</tr>
<tr>
<td>Secure Shell key management</td>
<td><strong>Tools</strong> &gt; <strong>Secure Shell User Keys</strong>, <strong>Tools</strong> &gt; <strong>Secure Shell Host Keys</strong></td>
</tr>
<tr>
<td>Telnet options</td>
<td><strong>Client Definition</strong> &gt; <strong>Advanced</strong> button &gt; <strong>Port</strong></td>
</tr>
<tr>
<td>XDMCP connection settings,</td>
<td><strong>Session Definition</strong> pane</td>
</tr>
<tr>
<td>such as Method and Host name</td>
<td></td>
</tr>
</tbody>
</table>
### Installation and Migration

<table>
<thead>
<tr>
<th>Name in Reflection X version 14.x</th>
<th>Name/location in Reflection X Advantage</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>X server instances (config)</strong></td>
<td><strong>Server Definition</strong> pane</td>
</tr>
<tr>
<td><strong>X server templates</strong></td>
<td><strong>Server Definition</strong> pane</td>
</tr>
<tr>
<td>(for example, <strong>XDMCP_Broadcast</strong>)</td>
<td></td>
</tr>
</tbody>
</table>

Note: In Reflection X version 14.0, X server templates were provided to simplify configuring and opening pre-configured X server instances. These default templates are longer provided.

#### Display settings

| **X display number** | **Session Definition**  >  **Advanced**  >  **Require display number** (typically, Reflection X Advantage dynamically chooses a display number based on available ports). |

#### X Screen settings

<table>
<thead>
<tr>
<th><strong>Specify total number (of X screens)</strong></th>
<th>This setting has become an action. To add or remove an X screen, click the plus (+) or minus sign (-) in the title bar of the <strong>Screen Definition table</strong> (<strong>Server Definition</strong>  &gt;  <strong>Windowing</strong>).</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Virtual size (pixels) &gt; Width</strong></td>
<td><strong>Server Definition</strong>  &gt;  <strong>Windowing</strong>  &gt;  <strong>Screen Definition table</strong>  &gt;  <strong>Virtual Width (Pixels)</strong></td>
</tr>
<tr>
<td><strong>Virtual size (pixels) &gt; Height</strong></td>
<td><strong>Server Definition</strong>  &gt;  <strong>Windowing</strong>  &gt;  <strong>Screen Definition table</strong>  &gt;  <strong>Virtual Height (Pixels)</strong></td>
</tr>
<tr>
<td><strong>Dimensions (mm) &gt; Width</strong></td>
<td><strong>Server Definition</strong>  &gt;  <strong>Windowing</strong>  &gt;  <strong>Screen Definition table</strong>  &gt;  <strong>Width (mm)</strong></td>
</tr>
<tr>
<td><strong>Dimensions (mm) &gt; Height</strong></td>
<td><strong>Server Definition</strong>  &gt;  <strong>Windowing</strong>  &gt;  <strong>Screen Definition table</strong>  &gt;  <strong>Height (mm)</strong></td>
</tr>
<tr>
<td><strong>Place it on monitor(s)</strong></td>
<td><strong>Server Definition</strong>  &gt;  <strong>Windowing</strong>  &gt;  <strong>Screen Definition table</strong>  &gt;  <strong>Monitor</strong></td>
</tr>
<tr>
<td><strong>Full size (no title bar)</strong></td>
<td><strong>Server Definition</strong>  &gt;  <strong>Windowing</strong>  &gt;  <strong>Screen Definition table</strong>  &gt;  <strong>Hide title bar</strong></td>
</tr>
</tbody>
</table>

#### X Server settings

| **Back ing store and Save unders**     | **Server Definition**  >  **General**  >  **Back ing store** |
| **Enable X11R3 bug compatibility**    | **Server Definition**  >  **General**  >  **Permit X11R3 bugs** |
| **Confirm close when clients are connected** | **Session Definition**  >  **Advanced**  >  **Ask for confirmation before stopping session** |
| **X Server extensions**               | **Server Definition**  >  **Extensions** |
| **Log file**                          | Log files |
| **Log X protocol errors**             | **Session Definition**  >  **Logging**  >  **Log X protocol errors** |
## Font settings

<table>
<thead>
<tr>
<th>Name in Reflection X version 14.x</th>
<th>Name/location in Reflection X Advantage</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Font path</strong></td>
<td>Server Definition &gt; Fonts &gt; Server font path</td>
</tr>
<tr>
<td><strong>Log font activity</strong></td>
<td>Session Definition &gt; Logging &gt; Log font activity</td>
</tr>
<tr>
<td><strong>Allow font substitution</strong></td>
<td>Server Definition &gt; Fonts &gt; Allow font substitutions</td>
</tr>
<tr>
<td><strong>Try font server on client host</strong></td>
<td>Server Definition &gt; Fonts &gt; Use font server on X client host</td>
</tr>
</tbody>
</table>

## Color settings

<table>
<thead>
<tr>
<th>Name in Reflection X version 14.x</th>
<th>Name/location in Reflection X Advantage</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Default visual type</strong></td>
<td>Server Definition &gt; Windowing &gt; Screen Definition table &gt; Default Visual Type</td>
</tr>
<tr>
<td><strong>Colormap preallocation settings</strong></td>
<td>Server Definition &gt; Windowing &gt; Screen Definition table &gt; Black and White Pixels and Allocate B&amp;W in Client Maps</td>
</tr>
<tr>
<td><strong>Advertise linear visuals</strong></td>
<td>Server Definition &gt; Windowing &gt; Screen Definition table &gt; Linear Visuals</td>
</tr>
<tr>
<td><strong>Advertise single depth visuals</strong></td>
<td>Server Definition &gt; Windowing &gt; Screen Definition table &gt; Single Depth Visuals</td>
</tr>
</tbody>
</table>

## Security settings

<table>
<thead>
<tr>
<th>Name in Reflection X version 14.x</th>
<th>Name/location in Reflection X Advantage</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Host-based security</strong></td>
<td>Session Definition &gt; Network Security &gt; Host-based authorization</td>
</tr>
<tr>
<td><strong>User-based security</strong></td>
<td>Session Definition &gt; Network Security &gt; User-based authorization</td>
</tr>
</tbody>
</table>
| **FIPS mode**                     | From X Manager  
File > Preferences > FIPS Mode  
From the X Administrative Console:  
Domain Composition > Domain Security > FIPS mode |

## Network settings

<table>
<thead>
<tr>
<th>Name in Reflection X version 14.x</th>
<th>Name/location in Reflection X Advantage</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Disable remote TCP/IP connections</strong></td>
<td>Session Definition &gt; Network Security &gt; Allow remote IP connections</td>
</tr>
<tr>
<td><strong>Enable keep alives</strong></td>
<td>Session Definition &gt; Network Security &gt; Perform IP keep alives</td>
</tr>
<tr>
<td><strong>Log server network activity</strong></td>
<td>Session Definition &gt; Logging &gt; Log network activity</td>
</tr>
</tbody>
</table>

## Keyboard settings

<table>
<thead>
<tr>
<th>Name in Reflection X version 14.x</th>
<th>Name/location in Reflection X Advantage</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Backspace key sends</strong></td>
<td>Server Definition &gt; Keyboard &gt; Backspace sends</td>
</tr>
<tr>
<td>Name in Reflection X version 14.x</td>
<td>Name/location in Reflection X Advantage</td>
</tr>
<tr>
<td>-------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Allow clients to remap keyboard</td>
<td>Server Definition &gt; Keyboard &gt; Permit X clients to remap the keyboard</td>
</tr>
<tr>
<td>Host keyboard</td>
<td>Server Definition &gt; Keyboard &gt; Keyboard Map (select a predefined keyboard)</td>
</tr>
<tr>
<td>Keyboard map</td>
<td>Server Definition &gt; Keyboard &gt; Keyboard Map &gt; Edit (To create a custom keyboard map, start by cloning the default keyboard map.)</td>
</tr>
<tr>
<td>Mouse settings</td>
<td></td>
</tr>
<tr>
<td>Enable middle button emulation</td>
<td>Server Definition &gt; Mouse &gt; Enable middle button emulation</td>
</tr>
<tr>
<td>Middle button detection speed</td>
<td>Server Definition &gt; Mouse &gt; Middle button detection speed</td>
</tr>
<tr>
<td>Clipboard settings</td>
<td></td>
</tr>
<tr>
<td>Selection bound to clipboard</td>
<td>Server Definition &gt; General &gt; Selection bound to clipboard</td>
</tr>
<tr>
<td>Double-Byte Character support settings</td>
<td></td>
</tr>
<tr>
<td>Input Method</td>
<td>Session Definition &gt; Native IME Support</td>
</tr>
</tbody>
</table>

**Migrating Settings From Hummingbird Exceed**

The first time that you start Reflection X Advantage (either X Manager or X Manager for Domains), local settings from Hummingbird Exceed products (versions 9.0 and higher) are migrated automatically and saved to a Reflection X definition file (*.rxd). (Your existing Hummingbird files are not changed). A prompt appears asking if you want to import the migrated settings.

Note: If you choose not to import the settings when you first start X Manager or X Manager for Domains, you can import the migrated settings at a later time. Using this option gives you an opportunity to explore the default configuration before you import your migrated settings.

Use the following procedure if you decide to wait and import settings at a later time:
To import migrated settings from a definition file:

1. From X Manager or X Manager for Domains, click **File > Import**.
2. Browse to your Windows user profile folder to locate the definition file that contains your migrated settings. The definition file name identifies the product and version whose settings were migrated. For example: Exceed 12.00.rxd.
   - On Windows XP, the default location is: `Documents and Settings\<user>\.attachmate\rx\migration\`
   - On Windows 7 and Windows Vista, the default location is: `\Users\<user>\Documents\attachmate\rx\migration\`
3. In the **Import Definitions** dialog box, click ☑️ to select all the definitions.
4. Click **Import**.

Note: You can also migrate settings manually using the `rxmigrate` command line utility. This is useful if you have configured settings in a shared network location; these settings are not migrated automatically.

Uninstall Reflection X Advantage

Note: These procedures uninstall the Reflection X Advantage application. Reflection X Advantage databases, which contain your configuration information, are not removed.

To uninstall on Windows

1. Log on as an administrator.
2. From the **Windows Control Panel**, open **Programs and Features** (or **Windows Add or Remove Programs**, depending on your version of Windows.)
3. Select **Attachmate Reflection X Advantage**, click **Uninstall** (or **Remove**).

To uninstall on UNIX

1. Log on as root.
2. Open a terminal window and navigate to the `Uninstall_rxadvantage` directory, which is located in the Reflection X Advantage installation directory. The default location is:

   `/opt/rxadvantage/Uninstall_rxadvantage`
Enter the following command to initiate the uninstall and follow the uninstaller instructions.

```bash
./Uninstall_rxadvantage
```

Note: The command above launches the InstallAnywhere installation program which requires an X11 Windows display. To initiate a command line uninstall, you can add the parameters `-i console` as shown here:

```bash
./Uninstall_rxadvantage -i console
```

## To uninstall on a Mac

- You can uninstall X Manager by moving the following application into the trash:
  ```
  Applications > Reflection X Advantage > X Manager
  ```

- If you're running Reflection X in domain mode, you need to stop the Reflection X service before you can uninstall some features. To stop the service, you'll need to open a terminal window. For details, see Remove All Reflection X Files (page 25).

## Remove All Reflection X Files

Uninstalling Reflection X does not remove its associated files and directories. Use these procedures if you want to remove all associated files and directories.

### To remove files from a Windows installation

1. In the `%ALLUSERSPROFILE%` folder, remove the `.attachmate` folder and all of its subfolders.

   Note: This folder contains the database and logs used by X Manager for Domains.

2. In the `%USERPROFILE%` folder of any user who has configured X Manager, remove the `.attachmate` folder and all of its subfolders.

   Note: This folder contains the database and logs used by X Manager.

### To remove files from a UNIX installation

1. Delete the installation directory. The default location is:

   ```bash
   /opt/rxadvantage
   ```

   For example, navigate to the `opt` folder and enter:

   ```bash
   rm -fr rxadvantage
   ```

   Note: The `db` and `logs` subdirectories of the installation directory contain the database and logs used by X Manager for Domains.
2 Navigate to the home directory of any user who has configured X Manager and remove the .attachmate directory and all of its subdirectories:

   rm -fr .attachmate

---

**Note:** The .attachmate directory located in the user's home directory contains the database and logs used by X Manager.

---

**To remove a Mac installation**

1 Open a terminal window.

2 If the Reflection X service is installed and running, stop the service:
   
   sudo /Applications/Reflection X Advantage/rxs/bin/rxs stop

3 Delete the X Manager for Domains database and logs:
   
   sudo rm -fr /private/var/rx

4 Delete the X Manager database and logs:
   
   sudo rm -fr /Users/USER_NAME/.attachmate

5 If the Reflection X service is installed, delete boot scripts.
   
   sudo rm -fr /Library/StartupItems/RxService

6 Delete Reflection X Advantage application folder:
   
   sudo rm -fr /Applications/Reflection X Advantage

7 Delete all previous Reflection X Advantage package files from the Receipts folder. The syntax depends on your version.
   
   **Starting with Mac OS X 10.6:**
   
   sudo rm -fr /var/db/receipts/com.attachmate.rx.*

   **For earlier Mac OS X versions:**
   
   sudo rm -fr /Library/Receipts/Rx*.pkg
Use XDMCP to access your host desktop

This procedure uses X Manager to access your UNIX desktop. See the notes below if you are using X Manager for Domains.

---

**Note:** XDMCP must be enabled on your UNIX host.

---

**To connect using XDMCP**

1. Start X Manager.
2. Under **My Sessions** on the left, select the default session, called "(Untitled Session)".

   **Note:** Click the plus sign (+) to create additional sessions.

3. In the **Session Definition** pane on the right, in the **Session name** box, enter a name for the session.

   The name you enter is saved automatically, and appears under **My Sessions** on the left.

4. From the **On session start/reset** options, select **Initiate XDMCP**.

5. From the **Type** box, select **Direct**.

6. In the **Host name** box, enter the name or IP address of your host.
7 From the toolbar, click to start your session.

Note: You can also start a session by right-clicking the session name and clicking Start in the context menu, or by selecting the session name then clicking Action > Start, or by double-clicking the session name.

8 Enter your login credentials for the host.

Note: Once a session is established, two small green arrows appear to the left of its name under My Sessions. Status information for the session is displayed in the Session Status section on the right.

Doing more with this idea...

Once you have established a connection, Reflection X supports a number of features you might want to try. For example:

- Share your session with other users. For details, see Share a Session in the Reflection X Help.
- Create a desktop shortcut that launches your session. For details, see Create Shortcuts in the Reflection X Help.

Notes for creating sessions using X Manager for Domains

- X Manager for Domains is not installed by default.
- X Manager for Domains does not include default session and server definitions. You'll need to create a server definition before you can create your first session definition. Click the plus sign (+) under X Servers to create a new server. Each new definition uses the same default values as the "Generic X Server" definition provided in standalone X Manager.

Run an X Client Application on your Windows Desktop

This procedure configures a session that establishes a Secure Shell connection to the host, runs an X client application on your Windows desktop, and closes automatically when you close the client.

These are the basic steps. They are explained below.

Step 1: Create a server definition.
Step 2: Create a client definition.
Step 3: Create and launch a session.

Use server definitions to configure your display preferences. For example, the following procedure creates a server definition that displays each client window directly on your Windows desktop.
Step 1: Create a server definition

Note: As you edit the server definition, changes are saved automatically.

1. Start X Manager.
2. In the left pane, click the plus sign (+) next to **X Servers**.
   
   A new server definition appears.
3. In the **Server Definition** pane on the right, open the **Windowing** area and select **Show clients on my desktop**.
4. In the **General** area, **Name** field, specify a name for this server, such as "Clients on desktop."
   
   The name you enter is automatically saved and appears under **X Servers** on the left.

The client definition identifies the host you want to connect to, how you want to make the connection, and which X client application (or applications) you want to run. The next steps show how to make a Secure Shell connection (the default) and launch an X client using one of the available sample command lines.

Step 2: Create a client definition

Note: As you edit the client definition, changes are saved automatically.

1. From X Manager, in the left pane, click the plus sign (+) next to **X Clients**.
   
   A new client definition appears.
2. From the **Client Definition** pane on the right, enter a name for your client definition.
   
   The name you enter is saved automatically, and appears under **X Clients** on the left.
3. For **Host name**, specify the name or IP address of the computer that hosts your X client application.
4. Select a **Host type** from the drop-down list.
   
   Note: Changing the host type changes the list of sample client commands available in the **Command** drop-down list.
5. The default value for **Connection method** is **Secure Shell**. Leave this option selected.
   
   Note: The Secure Shell protocol (also known as SSH) provides a secure alternative to Telnet and other unsecured protocols commonly used to connect to X Windows hosts. Secure Shell connections require both server and user authentication, and all communications pass between hosts over an encrypted communication channel. Most hosts support this connection method. If your host does not, you may need to choose one of the other options.
6. Type in your user name, and password for the host.
7. From the Application box, select Single command.

8. In the Command text box, use the drop-down list to select one of the sample commands for starting an X client.

The session definition specifies which X server to use and which client (or clients) to start whenever you run this session. The session defined below also stops automatically when you close the client application.

**Step 3: Create and launch a session**

1. In the left pane, click the plus sign (+) next to My Sessions.

   A new session definition appears.

2. Select the session definition, and then enter a session name on the right.

3. From the Use X server list, select the server definition that you created earlier.

4. Set On session start/reset to Start X clients.

5. Click the plus sign (+) next to X Clients.

   The Add Clients dialog box appears.

6. From the Add Clients dialog box, select the client definition you just created, and then click OK.

7. From the On last client list, select Stop Session. (When this option is selected, your session stops automatically when you close your client application.)

8. From the toolbar, click ![ ] to start your session. (You can also start a session by right-clicking the session name and clicking Start in the context menu, or by selecting the session name then clicking Action > Start, or by double-clicking the session name.)

---

Note: The first time you connect to a host using Secure Shell, you see a Host Key Unknown dialog box. This indicates that the key required to authenticate this host is not yet included in your host key database. The administrator of the host can use the fingerprint displayed in this dialog box to help you confirm that you are connecting to the correct host. If you click Always in response to this prompt, the key is added to your known host key database and you won’t see this prompt again.

---

**Doing more with this idea...**

Once you have established a connection, Reflection X supports a number of features you might want to try. For example:

- Share your session with other users. For details, see Share a Session in the Reflection X Help.

- Create a desktop shortcut that launches your session. For details, see Create Shortcuts in the Reflection X Help.
The X Manager Interface

The X Manager interface is designed to be easy to use and customizable.

The Navigation and Definition Panes

When you first start X Manager, you see a navigation pane on the left that allows you move among definition panes on the right.

- **Navigation pane** — This pane contains the following sections:

  - **My Sessions**
    - This section may include either running sessions that you have started, joined, or left (X Manager for Domains), or session definitions (configurations settings for a session that is not running).

    When you first start X Manager, if you have migrated settings from Reflection X version 13 or 14, or from a Hummingbird Exceed product, you may see migrated session definitions.

    (X Manager for Domains) You may see a public session definition (page 102) created for you by an administrator.

    Note: To start, join, or leave a session, select it, right-click, and then choose the appropriate command.

  - **Offered Sessions**
    - (X Manager for Domains) If a session appears in this category, it's a session that another domain user has offered to you that you have or have not joined.

  - **X Clients**
    - This section contains the client definitions (configuration settings for a client) that you create.

    When you first start X Manager, if you have migrated settings from Reflection X version 13 or 14, or from a Hummingbird Exceed product, you may see migrated client definitions.

    (X Manager for Domains) If your administrator has created public client definitions for you, they will be present in this section.

  - **X Servers**
    - In X Manager, this section contains the default server definition **Generic X Server**, and any server definitions you create.

    When you first start X Manager, if you have migrated settings from Reflection X version 13 or 14, or from a Hummingbird Exceed product, you may see additional server definitions.

    (X Manager for Domains) If your administrator has created public server definitions for you, they will be present in this section.

    Note: To create a customized X server instance, clone an existing X server definition and edit the copy. Or, create a new instance of the X server by clicking the plus sign (+).
Reflection X Advantage

- **Definition panes** — The information that appears corresponds to the definition or session highlighted in the navigation pane to the left. When you highlight:
  
  - A definition that you own, you can edit it.
  
  - *(X Manager for Domains)* A public definition (a definition that is owned by your administrator), you *cannot* edit it.
  
  - A running session, you can view only **Session Status** and the settings for that session; you cannot change the way a session is configured until you stop it.

  Note: As you make edits, observe that there are no **OK** or **Apply** buttons — your changes are automatically saved.

**Customizing Your View**

You can customize your view from the **Preferences** dialog box, by hiding certain sections of the navigation pane, or changing the order in which they appear.

**Reflection X Icons**

The icons displayed in the left panel of X Manager — under **My Sessions**, **Offered Sessions**, **X Clients**, and **Servers** — show the status of the X Manager components available to you.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
</table>
| 🎈 | Session definition  
Configuration settings for a session. This session is not running. |
| 🎈 | Public session definition  
Session definition created by the administrator, and available to all users in the domain. This session is not running. |
| 🎈 | Session, currently running and joined  
The session has been started, and is currently being viewed on this computer. This session may appear under **My Sessions** or **Offered Sessions**. |
| 🎈 | Session, currently running and available to be joined  
The session has been started, but is not currently being viewed on this computer. This session may appear under **My Sessions** or **Offered Sessions**. |
| 🎈 | X client definition  
Configuration settings for starting an X client application. |
| 🎈 | Public X client definition  
X client definition created by the administrator, and available to all users in the domain. |
| 🎈 | Server definition  
Configuration settings for an X server. |
| 🎈 | Public server definition  
Server definition created by the administrator, and available to all users in the domain. |
When working with Fonts, Secure Shell Keys, and Color Schemes, the following icons display:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
</table>
| ![User key](image) | **User key**  
Secure Shell user key pair for connection to X clients. |
| ![Trusted host key](image) | **Trusted host key**  
Secure Shell host public key for connections to X clients. |
| ![Public trusted host key](image) | **Public trusted host key**  
Secure Shell host public key created by the administrator, and available to all users in the domain. |
| ![Font collection](image) | **Font collection**  
Font file set collection for use by X servers. |
| ![Public font collection](image) | **Public font collection**  
Font file set collection created by the administrator, and available to all users in the domain. |
| ![Color scheme](image) | **Color scheme**  
Configuration settings for colors in a color scheme, which can be used by an X server. |
| ![Public color scheme](image) | **Public color scheme**  
Color scheme created by the administrator, and available to users in the domain. |

The following icons appear on the Windows desktop when you create shortcuts:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
</table>
| ![Session shortcut](image) | **Session shortcut**  
Starts a specified session. |
| ![Client shortcut](image) | **Client shortcut**  
Starts a specified X client and an associated session. |

The following icons appear in the X Administrative Console.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
</table>
| ![Set user password](image) | **Set user password**  
Available from the Authentication pane when Authentication system is set to Internal. |
| ![Registered node](image) (online) | **Registered node** (online)  
On the Domain Composition pane. Indicates that the listed domain node is online. |
| ![Registered node](image) (not online) | **Registered node** (not online)  
On the Domain Composition pane. Indicates that the listed node is not available. |
Understanding Session Definitions

Session definitions are located under My Sessions in the left pane of X Manager.

A session definition includes a server definition that specifies the configuration settings for an X server. It can also include one or more client definitions that contain the settings for starting X client applications.

Use session definitions to establish sessions with X client applications. When you select a session definition that contains only a server definition, Reflection X starts an X session and leaves it to you to log in to the host and start an X client application. A session definition that contains both a server and one or more client definitions starts an X session and launches the X client applications, connecting them to the X server.

There are two types of session definitions:

- **Private session definitions**: Visible only to the user who owns it, and can be edited only by that user.

- **Public session definitions**: Visible to all users in the domain (page 100), but can only be created or edited by the administrator. Public definitions are available only when operating Reflection X in domain mode.

Notes:

- A session definition can be edited only by the user who created the session.

- Only domain administrators can create public session definitions. The domain administrator must be the owner of the definition to make it public.

- Any user can use the Export/Import Definitions features in Reflection X to share private definitions with another user.
Frequently Asked Questions

Can I edit my session definition while a session is running?
No. You must stop the session before you can edit the session definition.

Can I edit my client definition while a session using that definition is running?
Yes. However, it will have no effect on the currently running client — your edited client
definition will be used the next time you start a new session that uses that client definition, or
when you manually start it against a session.

Can I edit my server definition while a session using that definition is running?
Yes. However, it will have no effect on the current session — your edited server definition will
be used the next time you start a new session that uses that server definition.

Does a session definition require a client definition?
No. It's optional. If no client definition is present, no clients are automatically started.

Can a session definition start more than one client application?
Yes. You can add several client definitions to the same session definition.

Can I make a definition public?
The ability to create public definitions (page 102) is available when using the Reflection X
Administrative Console, and is limited to administrators only.

Can users other than administrators offer to share sessions with other users?
Anyone who starts a session can offer to share it with other users.

How and where are my settings saved?
Settings are saved automatically to the Reflection X Advantage database while you work.
Understanding Session Distribution

In this Chapter

- Reflection X Session Processes 37
- X Manager Basic Session 38
- X Manager Distributed Session 38
- Reflection X Domain Components 39
- X Manager for Domains Basic Session 40
- X Manager for Domains Distributed Session 41

Reflection X Session Processes

In Reflection X Advantage, a traditional X server is broken into separate cooperating processes — a client connector and protocol router; and one or more X servers. This combination of processes is referred to as an "X session." These processes may be distributed one or more computers, depending on how your configuration.

Client Connector and Protocol Router

The client connector and protocol router run together on the same computer. The client connector receives X protocol data from the X client application, converts it to a proprietary Reflection X protocol, and then sends it to the protocol router.

The protocol router serves as the hub of traffic for a Reflection X session — it transmits the protocol it receives from the client connector.

X Server

The X server receives and processes data from the protocol router. Reflection X has two types of X servers:

- **X server display**
  This server creates the X client application display and returns user input (for example, keyboard or mouse) to the protocol router, which sends it on to the client program. A shared session may have multiple X server displays.

- **Headless X server**
  This server has no physical display, yet processes all X protocol. When enabled, the headless X server can short-circuit inquiry-only requests, removing the need to forward these requests across slow connections to X server displays on user desktops. When a session is suspended, the headless server keeps it alive by continuing to process client requests.
**X Manager Basic Session**

X Manager (the standalone session manager) is installed by default. When you run sessions from X Manager, all processes initially run on the X Manager workstation, data flows directly between the X Manager and the X client host, and the server display is created on the X Manager. (By sharing your session, you may create additional X server displays on remote computers.) Remote session services are supported.

Note: All definitions used by the standalone X Manager are stored in the Reflection X database on the X Manager workstation.

1. When you start X Manager it retrieves session settings from the database on your workstation.
2. When you launch a session, the client connector and protocol router are created on your workstation, and the client connector connects to the X client application.
3. The X server display is created on your workstation, and all X protocol commands pass between the two computers.

**X Manager Distributed Session**

A distributed session can improve performance where high latency (page 101) or low bandwidth is a problem in your network (typically because your X client host is located far from your X Manager workstation). This configuration can also resolve problems using XDMCP when you are connecting through a VPN.

To configure a distributed session, you use Remote session services. To support this feature from the standalone X Manager, you need to install the Remote Session Services feature on the X client host or on a UNIX computer with a fast connection to that host. For details, see Improve Performance over a Slow Network in the Reflection X Help.

Note: All definitions used by the standalone X Manager are stored in the Reflection X database on the X Manager workstation.

Here is the sequence of events on a high latency network when Remote session services is set to High-latency network performance. In this example the Remote Session Services feature is installed and running on the X client host.

1. When you start X Manager it retrieves session settings from the database on your workstation.
2. When you launch a session, the client connector and protocol router are created on the X
Client host, and the client connector connects to the X client application. Reflection X
automatically measures the latency of the connection and creates a headless X server on
the X client host if the delay is significant enough to affect performance.

3. The X server display is created on your workstation, and only those X protocol commands
that are required for the display pass between the two computers.

Note: In high latency networks, this configuration improves performance by short circuiting
some of the data exchange over the network. With the headless X server running on the client
host, client/server exchanges that aren’t required to create the display pass between the client
and the headless X server, but aren’t sent on to the X server display on the workstation. This
reduces the number of round trip network messages, and this can improve the response time
you see on your workstation. In addition, if the network exhibits low bandwidth, the protocol is
compressed between the protocol router and the X server display.

Reflection X Domain Components

A Reflection X domain typically involves more than one computer.

The Administrative Console
Used by domain administrators to set up and centrally manage the domain.
This application is typically installed on the domain controller. You can also
install it on additional workstations to manage the domain from those
computers.

X Manager for Domains
Used by domain users to run and configure sessions.

Domain Controller
The domain controller runs the Reflection X service, including the domain
controller process. The service runs continuously and listens for requests to
access the domain. The database that centrally stores session information is
located on the domain controller.
Domain Node
A domain node runs the Reflection X service and supports remote session services. The domain controller can act as a domain node. In addition you can create additional nodes by installing the Reflection X service (without the domain controller feature) and joining the node to the domain using the rxsconfig utility.

X client host
This is the computer running your X client application.

Note: Because you can install Reflection X on UNIX computers, you can install any or all of the domain components described above on this host.

X Manager for Domains Basic Session
A basic session is one in which all session components run on the user's workstation. This is the default X Manager for Domains configuration (Remote session services is set to none). Remote session services (such as the ability to suspend and resume session, and improved performance in slow networks) are not available with this configuration. This configuration does support the ability of a domain administrator to provide users with predefined public session definitions. In addition, users can configure and run their own private sessions.

Note: All public and private definitions used by X Manager for Domains are stored in the Reflection X database on the domain controller and can be accessed from any computer in the domain.

Here is the sequence of events when Remote session services is set to none:

1. When a user logs on to a domain, the domain controller authenticates the user, after which the user can access session definitions stored in the domain database.

2. When the user starts a session, the domain controller sets up the session components on the user workstation.

3. The X protocol flows directly from the X client to the session on the workstation.
X Manager for Domains Distributed Session

Reflection X sessions that use Remote session services can have several advantages over basic sessions, including session persistence and improved performance in high latency or low bandwidth networks.

All of the following Remote session services options create a distributed session. In a distributed session, the client connector and protocol router are created on a remote domain node, not on the workstation running X Manager for Domains. Each of these options also supports creating a headless X server on that domain node. The difference between the options is in how they control creation of the headless X server.

- **Session suspend/resume**
  A headless X server is created on the domain node only when you leave the session or close X Manager for Domains. This enables you to rejoin the session at a later time.

- **Session suspend/resume; High-latency network performance**
  Reflection X automatically measures the latency of the connection and creates a headless X server if the delay is significant enough to affect performance. The headless X server helps improve performance by reducing the amount of data that needs to pass over the network.

- **Session suspend/resume; High-latency network performance; Network fault tolerance**
  This option forces creation of a headless X server whenever the session is running. This can improve performance where high-latency is a concern and also ensures that the session remains running even if a workstation is disconnected due to a power or network failure.

Note: In this configuration, all public and private definitions are stored in a Reflection X database on the domain controller.
Here is a sample sequence of events when **Session suspend/resume; High-latency network performance; Network fault tolerance** is enabled.

1. The user logs into the domain.

2. When the user starts a session, the domain controller sets up the session processes (a client connector, protocol router, and a headless X server) on a domain node. It also starts an X server on the user's workstation.

3. The X client starts and establishes a connection with the client connector. All X protocol passes to the headless X server on the domain node.

4. The X protocol required to maintain the display is passed on to the X server display on the workstation.
Note: In high latency networks, this configuration improves performance by short circuiting some of the data exchange over the network. When a headless X server is running, client/server exchanges that aren't required to create the display pass between the client and the headless X server, but aren't sent on to the X server display on the workstation. This reduces the number of round trip network messages, and this can improve the response time you see on your workstation.

Compression to Remote Workstations

If you are connecting over a low bandwidth network, protocol compression can improve performance. Reflection X is configured by default to compress protocol to remote X servers automatically whenever it detects low bandwidth (Compress protocol to remote X server displays = Dynamic). When you configure a distributed session (as shown above), the protocol that passes between the domain node and the workstation (identified with the label 4 in the diagram above) will be compressed automatically if low bandwidth is detected.
Using Reflection X Domains

In this Chapter

- Setting up Domain Components
- Domain Authentication
- Sample Domain Configurations

A Reflection X domain consists of one or more computers on which X session components run and are load-balanced. The domain also defines a group of users who can run and share sessions on those computers.

Reflection X domains can be set up in many different ways, with several optional components. To review some sample domain configurations, see Sample Domain Configurations (page 57).

Setting up Domain Components

Use the information in this section to set up the domain controller, start and stop the Reflection X service, set up administrator and user workstations, set up and remove domain nodes, and manage session persistence and performance.

Set Up the Domain Controller

Each Reflection X domain requires one domain controller. You can run the domain controller on any supported platform.

To set up the Reflection X domain controller

1. Install the following features:
   - X Administrative Console
   - Domain Services (including the Domain Controller feature)

   Note: The Reflection X Service, configured to run the domain controller, starts automatically.

To create an administrator's account for the domain, you'll log into the domain using the X Administrative Console.
To log on to the domain the first time

1. From the domain controller, start the X Administrative Console.
   
   You'll see the domain logon dialog box.

2. Enter the following information to log on to the domain:
   
   - For **User name** and **Password**, specify any user who can log onto this computer (the computer running the domain controller). The name you specify for your initial login will be the default domain administrator.
   
   - For **Domain**, enter the name of this computer. The Reflection X domain name is always the same as the name of the computer running the domain controller.

   Notes:

   On Windows systems, the first domain user must be a user who is a member of the same Windows domain as the user who installs Reflection X.

   On UNIX systems PAM authentication is used by default for user authentication. On some UNIX systems, the pam_securetty module is configured by default to allow root logins only if the user is logging in on a secure tty. On these systems you cannot log onto the Reflection X domain using root credentials.

3. From the tabs located along the left-hand side of the window, click **Authentication**.
   
   Notice that your name is already added to the list of user accounts and is selected as the administrator. By default, the first user to log on is set as the Reflection X domain administrator.

Start and Stop the Reflection X Service

The Reflection X Service (RXS) starts automatically when you install it, and when the computer reboots. However, you may need to stop or restart the service as part of a troubleshooting procedure.

Note: If X Manager for Domains or the Administrative Console is open, you must log off before you stop or restart the Reflection X service.

To start, stop, or restart the Reflection X Service

<table>
<thead>
<tr>
<th>System</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows</td>
<td>Open the Windows Services Management Console. (From Control Panel, go to <strong>Administrative Tools &gt; Services</strong>.) Select <strong>Attachmate Reflection X Service</strong> to, start, stop, or restart the service.</td>
</tr>
</tbody>
</table>
UNIX and Linux

You can start, stop, or restart the service from the command line via the init.d system using the rxs command. For example:

/etc/init.d/rxs start
/etc/init.d/rxs stop
/etc/init.d/rxs restart

The path to init.d depends on your operating system:

Default: /etc/init.d
HP-UX: /sbin/init.d
Red Hat: /etc/rc.d/init.d

AIX

On AIX, you can start or stop the service via the System Resource Controller (SRC) by entering one of the following commands.

startsrc -s rxs
stopsrc -s rxs

To restart the service, you must enter the stop command followed by the start command.

Mac

To start, stop, or restart the service, open a terminal window and enter one of the following commands:

sudo /Applications/Reflection X Advantage/rxs/bin/rxs start
sudo /Applications/Reflection X Advantage/rxs/bin/rxs stop
sudo /Applications/Reflection X Advantage/rxs/bin/rxs restart

Set Up an Administrator Workstation

A Reflection X domain administrator's workstation can be the domain controller, or any computer that has access to the domain controller.

To set up the administrator's workstation

1. Install the following features:

   X Administrative Console
   X Manager for Domains

2. To log onto the X Administrative Console, enter the username and password of the domain administrator. For instructions on creating this administrator account, see Set up the Domain Controller (page 45).
Set Up Domain Nodes

Adding nodes to a Reflection X domain is optional. Typically nodes are configured to support either or both of the following:

- Run sessions on a node at or near a remote X client host to improve performance over a slow network.
- Run sessions on multiple nodes to provide load balancing where remote session services are required by many users.

To add a node to a Reflection X domain, you’ll install the Reflection X service on the computer you want to add as a node, then use the rxsconfig utility to add join this computer to the Reflection X domain. Use X Administrative Console to confirm that the computer has been added as a node and optionally modify settings for this node.

Before you begin

- Set up the domain controller (page 45).
- Know the name of the computer running the domain controller (this is the domain name for your Reflection X domain, and the user name and password of the Reflection X domain administrator).
- Have administrator (or root) credentials for the computer you want to add as a node.

To set up a domain node

1. Log onto the computer you want to designate as a node using an administrator (or root) account.
2. Run the Reflection X installer and select the feature called Domain Services (without including the Domain Controller feature).

Note: You can create a node on any supported platform. For information about downloading and launching the installer see Install Reflection X Advantage on Windows (page 11), Install on UNIX (page 14), or Install on a Mac (page 15).

3. Open a Command Prompt window (Windows) or terminal window (UNIX or Mac) and run the following command, where "domainname" is the name of the computer running the domain controller.

   rxsconfig join domainname

Note: On UNIX systems, include full path information for rxsconfig. The default install location is shown in this example/op:

   /opt/rxadvantage/rxsconfig join domainname
4 You'll be prompted for Administrator credentials. Enter the user name and password of the Reflection X domain administrator. You'll see a message saying that node was successfully created. In this example, the node uses the default port, 22001.

```
C:\>rxsconfig join domainname
Initializing crypto library...
Performing the join...
Administrative user for domain: joe
Password:
Created node 0.0.0.0:22001 for domain domainname.
```

5 On the computer on which you have installed the Reflection X Administrative Console, open the Console and log on using the domain administrator credentials. Click the Domain Composition side tab.

You should see the node you just created listed under Registered Nodes.

6 (Optional) Edit the Registration Details for this node.

Note: The Participate in domain setting is selected by default. This is required for domain participation. If you clear this setting, existing sessions can continue to run but new sessions won't be able to use this node.

7 (Optional) If you are adding multiple nodes, select a Load balancing scheme.

Note: You can configure the domain controller to act as a domain node. To do this, use the procedure above, omitting step 2.

---

**Remove a Domain Node**

Use the rxsconfig command line utility to remove a node from a domain.

**To remove a domain node**

1 Log onto the computer that is currently configured to be a Reflection X domain node using and administrator (or root) account.

2 Open a DOS window (Windows) or terminal window (UNIX or Mac) and run the following command, where "domainname" is the name of the computer running the domain controller.

```
rxsconfig leave domainname
```

Note: On UNIX systems, include full path information for rxsconfig. The default install location is shown here:

```
/opt/rxadvantage/rxsconfig leave domainname
```

3 You'll be prompted for administrator credentials for the domain. Enter the user name and password of the Reflection X domain administrator. You'll see a message saying that node was successfully deleted.
Set Up User Workstations

To run sessions in domain mode, install X Manager for Domains and log onto the domain.

To set up user workstations

1. Install the following feature.
   
   **X Manager for Domains**

2. Start X Manager for Domains.
   
   You'll see the domain logon dialog box.

3. Log on to the Reflection X domain.
   
   - For **Username** and **password**, enter your credentials to log onto the Reflection X domain. If your domain is configured to use the default authentication option (Windows authentication on Windows systems and PAM authentication on UNIX systems), you can log on using the same credentials you use to log on to your computer.

   - For **Domain**, enter the Reflection X domain name. (The Reflection X domain name is always the same as the name of the computer running the domain controller.)

Note: From X Manager for Domains you can access any public session definitions that have been created in this domain. You can also configure your own private session definitions, which are not visible to other users. All session definition information is stored on the domain controller in the domain database.
Manage Session Persistence and Performance

If you are running in domain mode, you can use Reflection X remote session services to provide both session persistence and improved performance on some networks. Remote session services are configured on a per session basis from X Manager for Domains or the Administrative Console. These settings determine when and where sessions are held in memory.

Notes:

- The default Remote session services setting is None. To use any of the other remote session services, you must be connected to a domain with at least one domain node available. For information about setting up a domain and additional information about the options described here, see Getting Started with Reflection X Domains (page 57).

- When you exit X Manager for Domains, your currently running sessions may stop or they may continue to run as suspended sessions. What happens depends on your setting for Remote Session Services, your setting for On exiting X Manager, and whether or not you leave the session before you exit X Manager for Domains. For example, if Remote Session Services = Session/suspend resume, On exiting X Manager = Stop all sessions, and you exit X Manager for Domains with a session window still open, Reflection X automatically stops the session. If On exiting X Manager = Leave all sessions if possible and you exit X Manager for Domains with a session window still open, or with a session suspended, the session will continue to run as a suspended session.

To configure remote session services

1. Start X Manager for Domains.
2. As part of creating a session definition, expand the General section in the Session Definition pane.
3. Under Remote session services list, select one of the following settings:
   - **None**
     (Default). With this option, your session remains available as long as X Manager for Domains is running. The session ends when you close X Manager for Domains or your workstation shuts down.
   - **Session suspend/resume**
     Use this option to be able to rejoin a session even after you close X Manager for Domains and shut down your workstation.

     Note: With this configuration, your session does may not persist if your workstation shuts down unexpectedly.

   - **Session suspend/resume; High-latency network performance**
     Use this option to improve performance when you connect to an X client over a high-latency network (typically one in which your X Manager for Domains workstation is located far from the X client host computer).
Note: With this configuration, your session does not persist if your workstation shuts down unexpectedly.

**Session suspend/resume; High-latency network performance; Network fault tolerance**

Use this option to ensure that your session is guaranteed to remain running even in the event that your workstation shuts down unexpectedly. (This option also improves performance when you connect to an X client over a high-latency network.)

Use **Stop suspended session after <n> minutes** to shut down the session automatically if it has been suspended for the specified time without being rejoined. This setting applies if the session is suspended because of an unexpected shutdown and also if you suspend the session by selecting **Leave** in response to the **Confirm Exit** prompt. This option is not available when **Remote Session Services** is set to **None**.

**Domain Authentication**

To use the domain features you need to log into the Reflection X domain. When you start X Manager for Domains and the Administrative console, you'll be prompted for your domain credentials. The required credentials depend on how domain authentication is configured.

Reflection X Advantage supports the following authentication methods: Windows, PAM (Pluggable Authentication Modules), LDAP (Lightweight Directory Access Protocol), and Reflection X Internal.

The default Reflection X authentication method depends on the operating system of the computer on which you installed the domain controller. On a Windows computer, Windows authentication is used. On a UNIX or Mac computer, PAM authentication is used.

**How Domain Access is Controlled**

You can leverage your authentication process to provide Reflection X Advantage authentication. Reflection X Advantage supports the following authentication methods:

- **Windows**
  The default authentication system when the Reflection X domain controller is installed on a Windows system.

- **PAM (Pluggable Authentication Modules)**
  Available for several non-Windows operating systems. This is the default authentication system when the Reflection X domain controller is installed on a non-Windows system.

- **LDAP (Lightweight Directory Access Protocol)**
  A generic way of authenticating users that can be used with a number of directory servers that support LDAP. The configuration of LDAP authentication allows it to be used with different LDAP servers that have non-standard schema.

- **Reflection X Internal**
  A lightweight mechanism for authenticating users. The Reflection X administrator manually maintains a list of users.

The default Reflection X authentication method depends on the operating system of the computer on which you installed the domain controller. If it is installed on a Windows computer, Windows authentication is used. If it is installed on a non-Windows computer, PAM authentication is used.
You can set up your authentication system either to add users to the domain automatically when they log on, or to require that users must be added individually. (Requiring individual assignments allows you to provide access to only a subset of known users.)

Note: Automatically adding users is supported for all authentication methods except the Internal method.

### Configure and Test User Authentication

Use the Administrative Console to test and configure user authentication. Basic procedures to help you get started are outlined here. For additional information, see Domain Authentication (page 52).

If you install your domain controller on a computer that is joined to a Windows domain, users with accounts in the same Windows domain can log onto the Reflection X using their Windows domain credentials. No additional configuration is needed. You can use the following procedure to test user authentication to the Reflection X domain.

#### To test authentication using Windows credentials

1. Start Reflection X Administrative Console and log on to the Reflection X domain.
2. From the tabs located along the left-hand side of the window, click **Authentication**.
3. Click **Test Authentication** to test credentials for any valid Windows domain user.

If you install your domain controller on a UNIX system, PAM authentication is used by default. Any user who can log onto the UNIX computer can log onto the Reflection X domain. You can use the following procedure to test user authentication to the Reflection X domain.

#### To test authentication on UNIX systems

1. Start Reflection X Administrative Console and log onto the Reflection X domain.
2. From the tabs located along the left-hand side of the window, click **Authentication**.
3. Click **Test Authentication** to test credentials for any valid account on the UNIX computer.

The internal authentication system is a light-weight authentication system that is available on all supported platforms. You may find it useful for testing or to set up a domain for a small group of users.

#### To configure Internal authentication

1. Start Reflection X Administrative Console and log onto the domain.
2. From the tabs located along the left-hand side of the window, click **Authentication**.
3. Set **Authentication system** to Internal.
4 Click ☰️ (or Action > Set user's password) to set your password in the Internal authentication database.

Note: Although an administrator account was created when you first logged on, the internal authentication database has no record of your password for this account because authentication was handled by Windows or PAM. You need to manually add users and set passwords when you use Reflection X Internal authentication. This is not required for the other authentication methods because authentication for Windows, PAM, or LDAP is managed by those systems. If you change to Internal authentication from the default authentication, any user who was added automatically will not be able to log on until you set a password for that user.

5 Click Test Authentication and test your credentials to confirm that you can still log on to the domain using this account.

Caution: After changing the authentication system, always test the administrator account before you log off. Without a valid administrator account, you won't be able to log on to the domain. (If you do find yourself locked out of your domain, a recovery option (page 56) is available.)

6 Click ☰️ (or Action > New User) to add additional users to your domain. Enter a username and password for each user.

Set Up LDAP Authentication

LDAP (Lightweight Directory Access Protocol) offers a generic way of authenticating users and can be used with a number of Directory Servers that support LDAP. The configuration of LDAP authentication allows it to be used with different LDAP servers that have non-standard schema.

Before you begin

- Add the computers that you have designated as domain components to the domain and configure the components.

Caution: Do not log off the domain without defining an administrative account. Without an administrative account, you cannot log on to the Administrative Console to manage your domain. (If you cannot log on because you do not have an administrative account, follow the instructions for unlocking a domain.)

To set up LDAP authentication

1 On the computer on which the Reflection X Administrative Console is installed, use the Administrative Console to log on to the domain.

2 From the Authentication tab, in the Authentication system list, select LDAP and then click Configure.

3 From the LDAP Configuration dialog box, enter the configuration data for your LDAP server.

4 After you change authentication methods, make sure the domain has an administrative account and password that you can use to log on to the domain.
5 Click **Test Authentication** to make sure the account is valid.

### Set Up Reflection X Internal Authentication

The Internal authentication system is a lightweight mechanism for authenticating users.

### Before you begin

- Add the computers that you have designated as domain components to the domain and configure the components.

---

Caution: Do not log off the domain without defining an administrative account. Without an administrative account, you cannot log on to the Administrative Console to manage your domain. (If you cannot log on because you do not have an administrative account, follow the instructions for unlocking a domain.)

---

### To set up Reflection X Internal Authentication

1. On the computer on which the Reflection X Administrative Console is installed, use the Administrative Console to log on to the domain.

2. From the Administrative Console **Authentication** tab, in the **Authentication system** list, select **Internal**.

3. On the **User Accounts** list, click **+**, and then from the **Add user to domain** dialog box, enter a user name and password for your administrative account.

4. In the **Administrator** column, choose to provide administrative permissions for the account.

### Add or Remove Domain Users

You can set up your Reflection X domain so that users are automatically added to the domain when they log on. (This is supported for all authentication systems except the Internal system.) If you want to have more control over access, you can set up the domain so that users must be added or removed individually.

### To allow access to all users in external authentication system

- In the Reflection X Advantage Administrative Console, from the **Authentication** tab, select **Automatically create user account after successful logon**.

All users who are in the authentication system are allowed access to the Reflection X domain. The first time a user logs on to the domain, his or her user account is added to the domain.

---

Note: If you are using Reflection X Internal Authentication, you cannot automatically create accounts when users log on.
**To allow access to selected users only**

1. In the Reflection X Advantage Administrative Console, from the Authentication tab, clear *Automatically create user account after successful logon*.

2. To add a user, on the User Accounts list, click +, then, from the Add User to Domain dialog box, enter the user name and password (if you are using Internal authentication) you want to add.

3. To give the new user account administrative permissions, select the box in the Administrator column.

4. To remove a user, in the User Accounts list, select the user name to remove and click –.

**Unlock a Domain**

You can be locked out of a domain if you forget the administrator password, change authentication methods without adding an administrative account, or experience a problem with the external authentication system.

You can unlock the domain using the rxsconfig command line utility's recovery option.

**To unlock a domain using rxsconfig**

1. Log on the server on which the Domain Controller is installed as an administrator (Windows) or root (UNIX).

2. Open a command window.

   Note: If you are running on Vista, Windows 7, or Windows Server 2008, you need to open the command window as an administrator. (In the Start menu, under Accessories, right-click Command Prompt and select Run As Administrator).

3. Enter the following command:

   rxsconfig recover

4. Restart the service (page 46).

5. Open the Administrative Console and log on to the domain with the following user name and password:

   user name: recovery

   password: recovery

   Note: Running the recovery command allows access to the Administrative Console only once. After you log out, these login values for username and password won't work again. To log in again with these values you need to repeat steps 1 through 3.

6. Set *Authentication system* to the authentication system you want to use for the domain.

7. Click the plus sign (➕) to add a new administrative user account.
8 Select the check box under Administrator for the new account.

9 Click Test Authentication then enter the name and password for this account and click Test to make sure that the account is valid.

---

Caution: Don't close the Administrative Console without first redefining and testing an administrative account. Without a valid administrative account, you won't be able to log back into the Administrative Console and you'll need to repeat this procedure from the beginning.

---

Sample Domain Configurations

These sample configurations show how to set up domains that offer solutions to common problems.

In this Section

- Domain Setup: Improve Performance Over a Slow Network
- Domain Setup: Leave a Session and Rejoin from a Different Computer
- Domain Setup: Centralize Session Configuration

Domain Setup: Improve Performance Over a Slow Network

This sample configuration demonstrates how you can configure a Reflection X domain to improve performance where your network configuration causes delays that make running a remote X client application difficult.

Note: This configuration uses Reflection X domain components to provide remote session services for connections from X Manager for Domains. You can also configure remote session services for connections from the standalone X Manager. For details, see Improve Performance over a Slow Network in the Reflection X Help.
In this configuration, the session runs two joined X servers. An X server display runs on the user workstation (1). This server creates the visual display of the X client application. An additional headless X server (page 100) (3) runs on a domain node located on or near the X client application. When a session is established, all X protocol passes between the X client application (4) and the headless server. Only the protocol required to update the display is sent to the workstation. Because many X protocol queries don't need to be sent to the workstation, this configuration improves performance by reducing the amount of traffic that needs to pass over the network. Reflection X also automatically detects low bandwidth conditions, and compresses protocol that flows between the user workstation (1) and the domain node (3).

The components of this configuration are:

<table>
<thead>
<tr>
<th>Computer</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User workstation (1)</td>
<td>Runs X Manager for Domains. The X server display is created on this computer. When this workstation is located a long distance from the X client host, high latency is a common problem. Without the domain configuration described below, the user sees poor performance when trying to interact with the X client application.</td>
</tr>
<tr>
<td>Domain controller (2)</td>
<td>Runs the Reflection X domain controller. (In this example, the Administrative Console also runs on this computer.) Session definition information is stored here and used to create a session on the domain node.</td>
</tr>
<tr>
<td>Domain node (3)</td>
<td>Runs a headless X server. This headless server communicates with the X client application and sends required data to the X server display on the user workstation. The domain node can be the X client host, or a nearby computer.</td>
</tr>
<tr>
<td>X client host (4)</td>
<td>The computer that runs the X client application.</td>
</tr>
</tbody>
</table>
To set up the domain components

1. On the domain controller, install the following features:
   - **X Administrative Console**
   - **Domain Services** (including the Domain Controller feature)
   - **X Manager for Domains**

2. From the domain controller, start the Administrative Console and log on.
   - For **User name** and **Password**, specify any user who can log onto this computer (the computer running the domain controller). The name you specify for your initial login will be the default domain administrator.
   - For **Domain**, enter the name of this computer. The Reflection X domain name is always the same as the name of the computer running the domain controller.

Notes:

On Windows systems, the first domain user must be a user who is a member of the same Windows domain as the user who installs Reflection X.

On UNIX systems PAM authentication is used by default for user authentication. On some UNIX systems, the pam_securetty module is configured by default to allow root logins only if the user is logging in on a secure tty. On these systems you cannot log onto the Reflection X domain using root credentials.

3. From the tabs located along the left-hand side of the window, click **Authentication**.
   Notice that your name is already added to the list of user accounts and is selected as the administrator. By default, the first user to log on is set as the Reflection X domain administrator.

4. Configure user authentication for your Reflection X domain (page 53).

   Note: A default option for **Authentication system** is configured automatically based on the operating system running the domain controller. In most cases, you can use this default authentication; no additional configuration is required.

5. On the domain node, install **Domain Services** and use the **rxsconfig** utility to add this node to your domain. For details, see Set up Domain Nodes (page 48).

6. On the user workstation, install **X Manager for Domains**.

To configure and start your session

1. From domain controller, start X Manager for Domains and log on using your administrator credentials.

2. Create and configure a session that launches your X client application, or uses XDMCP to access your UNIX desktop.

3. Under **My Sessions**, select your session.
4 In the **Session Definition** pane, under **Remote session services**, select a level of services that includes **High-latency network performance**.

5 Start your session.

In the **Session Status** area, under **X Servers**, you will see an entry for your workstation computer. If high latency is detected in your network connection, you'll see an additional entry for the headless X server. The headless X server will be located on the domain node.

**Doing more with this idea...**

Once you have this basic configuration running, you can build on it in a number of ways. For example:

- Add additional workstations to the domain and simplify connections for end users by configuring public sessions (page 63).
- Add scalability by adding additional domain nodes.

**Domain Setup: Leave a Session and Rejoin from a Different Computer**

This sample configuration demonstrates how you can configure a personal Reflection X domain that makes it easy for you to continue working from home on a session you started on your work computer. You can pick up your work exactly where you left off.
The components of this configuration are:

<table>
<thead>
<tr>
<th>Computer</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Office computer (1)</td>
<td>Runs the domain controller, X Manager for Domains, and the Administrative Console. You can access your sessions from any computer running X Manager for Domains that has access to this computer.</td>
</tr>
<tr>
<td>Home computer (2)</td>
<td>Runs X Manager for Domains.</td>
</tr>
<tr>
<td>X client host (3)</td>
<td>The computer that runs the X client application.</td>
</tr>
</tbody>
</table>

**To set up the domain components**

1. On your office computer, install the following features:
   - **X Administrative Console**
   - **Domain Services** (including the **Domain Controller** feature)
   - **X Manager for Domains**

2. From your office computer, start the Administrative Console and log on using your Windows domain credentials. For domain name, enter your computer's name.

3. From the tabs located along the left-hand side of the window, click **Authentication**.
   - Notice that your name is already added to the list of user accounts and is selected as the administrator. By default, the first user to log on is set as the Reflection X domain administrator. For this sample configuration, no additional authentication configuration is needed.
   - The next step configures your office computer to act as a domain node. By creating a node, you enable your domain to maintain a suspended session even after you close X Manager for Domains.

   Open a DOS window and run the following command:
   ```
   rxsconfig join localhost
   ```
   - You'll be prompted for Administrator credentials. Enter the user name and password you use to log onto this computer. You'll see a message saying that node was successfully created. In the Administrator Console you can now see your computer listed in the **Domain Composition** pane under **Domain Nodes**.

5. On your home computer, install **X Manager for Domains**.

**To configure and start a session at work**

1. From your work computer, start X Manager for Domains and log on with the same user name and password you used for the Administrative console. For domain, specify the name of your office computer.

2. Create and configure a session to connect to your UNIX desktop or client application.
Note: Unlike the standalone X Manager, X Manager for Domains includes no default server definitions. You need to create at least one server definition before you can configure and start a session.

3 Under **My Sessions**, select your session. In the **Session Definition**, under **Remote session services**, select **Session suspend/resume**.

4 Start your session and get some work done.

5 When it's time to go home, right-click the running session and click **Leave**.

6 Close X Manager and leave this computer running.

Note: Because you enabled session persistence and left the session running, the server remains active even though it is no longer producing a display. To confirm this, you can start the Administrative Console, click the **Domain Status** tab and view **Running Sessions**.

---

**To join your session in progress from your home computer**

1 Connect your home computer to your Virtual Private Network.

2 Start X Manager for Domains and log on with the same user name and password you used on your office computer. For domain, specify the name of your office computer.

3 Right-click your running session and click **Join**.

---

**Persisting a Session on a Remote Computer**

In the configuration shown above, the session components run on your office computer, which means that you need to leave that computer running if you want to rejoin the session from home.

Another possible configuration is shown below. In this configuration, the domain controller and domain node run on the same computer that runs the X client application. With this setup, you can leave your session and shut down both your home and office computer and the session will remain active on the X client host.
Domain Setup: Centralize Session Configuration

This sample configuration demonstrates how an administrator can use a Reflection X domain to simplify session setup for end users. In this example, the administrator configures public session definitions. End users can launch these public sessions from their workstations, and can also create and start their own sessions.

The components of this configuration are:

<table>
<thead>
<tr>
<th>Computer</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrative Workstation (1)</td>
<td>Runs X Administrative Console and X Manager for Domains. The administrator uses these to manage the domain, and to configure and share public session definitions.</td>
</tr>
<tr>
<td>Domain Controller (2)</td>
<td>Runs the Reflection X domain controller and X Administrative Console. Session information is stored on this computer in the domain controller database.</td>
</tr>
<tr>
<td>User workstations (3)</td>
<td>The user runs sessions configured by the administrator and optionally create additional private sessions.</td>
</tr>
<tr>
<td>Domain nodes (4)</td>
<td>(Optional) Runs remote session components when sessions are configured to use remote session services.</td>
</tr>
<tr>
<td>X client hosts (5)</td>
<td>The computers that run X applications used in your organization.</td>
</tr>
</tbody>
</table>

The administrator uses the Administrative console (1) to configure the domain controller (2). When users start sessions, the domain controller can set up session components on user workstations (3) or domain nodes (4):
The X server displays are created on user workstations using the centrally managed configurations:

These are the basic steps for setting up this configuration. They are explained below.

Step 1: Set up Reflection X domain components.

Step 2: Use X Manager for Domains on the administrative workstation to configure and test a session.

Step 3: Use the Administrative Console to make the session public.

Step 4: Use X Manager for Domains on the user workstation to connect using the public session.

**Step 1: Set up Reflection X domain components**

1. On the domain controller, install the following features:
   - **X Administrative Console**
   - **Domain Services** (including the **Domain Controller** feature)

2. From the domain controller, start the Administrative Console and log on.
   - For **User name** and **Password**, specify any user who can log onto this computer (the computer running the domain controller). The name you specify for your initial login will be the default domain administrator.
   - For **Domain**, enter the name of this computer. The Reflection X domain name is always the same as the name of the computer running the domain controller.
Notes:

On Windows systems, the first domain user must be a user who is a member of the same Windows domain as the user who installs Reflection X.

On UNIX systems PAM authentication is used by default for user authentication. On some UNIX systems, the pam_securetty module is configured by default to allow root logins only if the user is logging in on a secure tty. On these systems you cannot log onto the Reflection X domain using root credentials.

3 From the tabs located along the left-hand side of the window, click Authentication.

Notice that your name is already added to the list of user accounts and is selected as the administrator. By default, the first user to log on is set as the Reflection X domain administrator.

4 Configure user authentication for your Reflection X domain (page 53).

Note: A default option for Authentication system is configured automatically based on the operating system running the domain controller. In most cases, you can use this default authentication; no additional configuration is required.

5 On the administrative workstation, install the following features:

   X Administrative Console

   X Manager for Domains

6 On user workstations install X Manager for Domains.

7 If you are using domain nodes, install Domain Services on these computers and use the rxsconfig utility to add each node to your domain. For details, see Set up Domain Nodes (page 48).

Step 2: Configure and test a session

In the steps that follow, you'll use X Manager for Domains to configure and test a session.

Note: It is also possible to create session definitions using the Administrative Console, but starting with X Manager for Domains makes it easy to test your session configuration.

1 From the administrator workstation, start X Manager for Domains and log on using the same credentials and domain name you used to log onto the Administrative Console.

2 Create and configure a session to connect to your UNIX desktop or client application.

Note: If you are creating new client definitions, you should leave User name blank because you are going to share this session definition with others. After you make this session public, users can enter their name during the connection process.

3 (Optional) If you have configured domain nodes, you can configure any of the Remote session services options for this session.
4 Start your session.

If your connection is successful, you're ready to make this session definition available to other users.

---

**Step 3: Make the session public**

By default, a new session is private. A private session definition can be viewed, used, and modified only by the user who created it. To make your session available to other users, you need to make it public.

Note: When you make a session public, users also need access to the associated server definition and any client definitions it uses.

1. From the administrator workstation, start the Administrative Console and log on.
2. Right-click the session definition and select **Public**. Note that the icon changes to indicate that this is now a public session.
3. Right-click the server definition and select **Public**.
4. If your session uses any client definitions, make these public in the same way.

Now that the administrator's work is done, all a user needs to know to get connected is:

- Logon credentials for the Reflection X domain. (If you manually added users to the internal authentication database, you need to provide them with these credentials. If you use Windows or PAM for authentication, users can log on to the Reflection X domain using those credentials.)

- The name of the Reflection X domain. (The name of the computer running the domain controller.)

- Logon credentials for the X client host.

Here's how it works...

---

**Step 4: Make a connection from the user workstation using the public session**

1. From the user workstation, start X Manager for Domains. Log on using the log on and domain name values provided by the administrator.

2. Under **My Sessions**, find the session made public by the administrator. Highlight it and start the session.
Customizing and Distributing Reflection X

The following options are available for customizing and distributing Reflection X software, and centrally managing Reflection X sessions.

**Deploying Software**

Windows Installer (page 69) and Attachmate Customization Tool (page 73)

- **Features**
  - Install any or all components (standalone, domain mode, emulators, and FTP client).
  - Create a customized installation with the correct options for your users.
  - Create companion installers to add files to your installation.
  - Configure shortcuts.
  - Chain installations and/or run additional programs automatically with your customized installation.

- **Requirements and limitations**
  - Deploys to Windows systems only.
  - Software is not updated automatically after the install; an additional install must be made available to users.

**Distributing Sessions**

Set up a Reflection X domain to support centralized session configuration (page 63)

- **Features**
  - The domain administrator can provide preconfigured, public sessions for users.
  - Updates to centralized sessions are automatically available to users.
  - Users can configure and save personal sessions in addition to using public sessions.
  - By setting up a domain, you can take advantage of other domain services; such as session suspend/resume, and improved performance in high-latency or low bandwidth networks.

- **Requirements and limitations**
  - The domain controller and any required nodes must be installed and configured.
  - X Manager for Domains must be installed on user workstations.
Distribute sessions using the Reflection for the Web Administrative WebStation (page 85).

**Features**

- Manage sessions for multiple Reflection products from a single console.
- Configure sessions that launch X clients directly, without displaying the X Manager window.
- Connections go through the Reflection for the Web security proxy server, which provides SSL/TLS encryption to the proxy. The security proxy server can also restrict the visibility of your hosts over the network, which enables you to limit host access to authorized users and members of LDAP groups.

**Requirements and limitations**

- You must have Reflection for the Web, which is sold and licensed separately from Reflection X 2011.
- A Reflection for the Web proxy server must be configured, clients must connect using Secure Shell, and Reflection PKI Services Manager must be installed and configured to validate the security proxy certificate.
- Administrator and user workstations must be Windows systems, and X Manager (standalone) must be installed on these computers.
- Users who launch sessions from Reflection for the Web can't save X Manager settings.
Deploying with the Windows Installer

In this Chapter

Performing a Basic Deployment 70
Install from the Command Line 70
Performing an Advanced Deployment 71
Create an Administrative Installation Point 72
Attachmate Customization Tool 73
Creating and Editing Transforms 74
Creating a Companion Install Package 80
Deploying Reflection X 83

If you are installing to Windows Workstation, you install Reflection X using the Attachmate Installation Program (Setup.exe). You can choose from several different approaches for installing and deploying Reflection X. Deciding which approach to use is typically based on a variety of factors, including your approved business processes, the scale of the deployment, your deployment tools, and whether you want to customize the installation.

For example, a small-scale deployment might consist of using the Attachmate Installation Program to install Reflection X on a few workstations, whereas an enterprise-wide deployment would probably involve extensive customization and testing.

Use one of the following approaches, depending on your requirements.

- **Perform a Workstation Installation on each Workstation**
  Install all of the files for Reflection X to a PC hard drive. You might choose this approach if you are installing Reflection X on a small number of machines and you do not need to customize the installation.

- **Perform a Basic Deployment**
  Perform an administrative installation to copy Reflection X files to an administrative installation point. This is also referred to as creating an administrative installation image. Then, using deployment tools, you access these files and create packages that are deployed to workstations. A basic deployment is a good choice when you need to deploy Reflection X to a large number of workstations but you do not need to customize the installation.

- **Perform a Customized Deployment**
  Perform an administrative installation to copy Reflection X files to an administrative installation point (just as you would for a basic deployment). Then, you customize the installation to specify the way it installs, looks, and acts on the end users' computers. Customized deployments can be used to deploy to any number of workstations.
Performing a Basic Deployment

Perform a basic deployment when you need to install the default (uncustomized) Reflection X application on a large number of machines.

The following process is typical for a large-scale, basic deployment:

1. Perform an administrative installation (page 72) in a destination folder to create an administrative installation point.

2. Test the installation.

3. Deploy Reflection X from the administrative installation point. Because the installation package adheres to MSI standards, you can use Microsoft Active Directory or any other Microsoft Installer-compatible deployment tool.

Install from the Command Line

You can use the Attachmate Installation Program command line to install Reflection X from the distribution image, or from an administrative installation image. You can also include command-line options in a batch file to preset installation parameters, and limit user interaction while Reflection X is installing. You can even suppress installation dialog boxes to provide an unattended installation.

In addition, you can use command-line options to prepare Reflection X for installation by users. In general, any of the MSI command-line options can be used from the Attachmate Installation Program command line.

To install from the command line

At the command prompt or Start menu Run command, change to the directory in which the setup.exe file resides, and do one of the following:

- To create an administrative installation image, type:
  
  `setup.exe /install /admin TARGETDIR=path`

- To install to a workstation with typical settings, type:
  
  `setup.exe /install`

- To specify a non-default location for program files use INSTALLDIR. For example:
  
  `setup.exe /install INSTALLDIR=C:\path`

- If you are installing using the 64-bit installer for Reflection X 2011 or Reflection Suite for X 2011, use INSTALLDIR to specify the location for 32-bit components and INSTALLDIR64 to specify the location for 64-bit components. The two paths can be the same or different. For example:
  
  `setup.exe /install INSTALLDIR=C:\path INSTALLDIR64=C:\path`

Note: To view a list of the command-line options for customizing installations, change to the directory in which the setup.exe file resides and enter:

`setup.exe /?`
To install directly with MSI

- At the command prompt or Start menu Run command, change to the directory in which the msi file resides and enter:
  msiexec.exe /i installation_file_name.msi

Notes:

- If you install Reflection X directly from MSI, make sure that the prerequisite Microsoft .NET Framework Runtime software is installed on your users’ workstations before you install Reflection X. If MSI does not find this prerequisite software, it will not complete the installation.

- Running setup.exe removes previous versions of Reflection. This is a required step. Therefore, if an administrator deploys the Reflection .msi file directly, he or she must first uninstall Reflection manually. For more information, see Technical Note 2218 (http://support.attachmate.com/techdocs/2218.html).

- If you are installing Attachmate Reflection 2011 Release 2 directly from MSI and you want users to be able to run or develop Microsoft VBA macros, you will need to install Microsoft VBA 6.5 directly. (Use the core and language specific MSIs in the Prerequisites folder, in the distribution media.)

Performing an Advanced Deployment

Perform an advanced deployment when you need to customize your installation to:

- Limit an end user’s access to application features
- Customize the installation of the Reflection X files
- Create companion installation packages of custom files that can be installed independently from the main installation.

The following process is typical for large-scale, customized deployments.

1. Perform an administrative installation (page 72) in a destination folder to create an administrative installation point.

2. From the administrative installation point, do one of the following:

   - Create standard MSI transforms (page 74) to modify the primary installer database.
     You can specify the install location, set feature states, modify or remove shortcuts, remove older products, and chain other installs or programs.
     -or-

   - Create companion install packages (page 80) that include the custom files you created on the workstation.
     You can install these separate MSI packages independently of the Reflection X install. This allows you to upgrade the product without removing these custom files. It also allows you to install or remove the custom files without installing or removing the main Reflection X files.
3. Test the installation.

4. Deploy Reflection X with the transforms you created, as well as any separate MSI packages.

Because the transforms and companion installation packages adhere to MSI standards, you can use a desktop shortcut, Microsoft Active Directory, or any other Microsoft Installer-compatible deployment tool.

Create an Administrative Installation Point

To prepare your environment for deployment, you will need to create an administrative installation point. You do this by installing an administrative install image of Reflection X on a network share (typically on a file server). An administrative install image is a source image of the application, similar to an image on a DVD. It includes all the files required to install Reflection X as well as the administrative tools used for customization.

Caution: For this procedure, use only the Advanced and File Location tabs. Configurations made from other tabs will be ignored.

Notes:

- Attachmate’s recommended practice is to create an administrative installation point before you install Reflection X on a workstation. This allows you to use the administrative installation point for the workstation installation.

- If you prefer to use a command line instead of the Attachmate Installation Program graphical interface, you can create an administrative install image from the command line as follows:

  ```
  path_to_setup_file\Setup.exe /install /admin
  TARGETDIR=UNC_path_to_administrative_installation_point
  ```

- If you prefer to install Reflection X on your workstation first, you must create the administrative install image from the command line as follows:

  ```
  path_to_setup_file_on_your_workstation\Setup.exe /install /admin
  TARGETDIR=UNC_path_to_administrative_installation_point
  ```

---

To create an administrative install point

1. Create a network share on a network file server.

2. Click the download link, and then run the download program. Select a location for the installer files, and then click Next.

   This extracts the files to the specified location and starts the Attachmate Installation Program. (If you have already downloaded the files, click the setup.exe file to start the installation program.)

3. Click Continue and accept the license.

4. From the Advanced tab, click Create an Administrative install image on a server.
5 Click **Continue**, and then browse to the network share you want to use for the administrative install image.

---

**Important!** Be sure to specify the path to the network share as a UNC path (for example: `\share_name\administrative_install_point`).

---

6 Click **Install Now**.

---

**Note:** Administrative installation images are typically created in a file server folder. However, you can create administrative installation images in any folder on a local hard disk, which can be useful for testing purposes.

---

**Attachmate Customization Tool**

The Attachmate Customization Tool is a special mode of Attachmate Installation Program (setup.exe) that supports custom modifications to the primary install and includes some limited deployment facilities. These are accomplished with a simple user interface, and do not require additional software packages or training.

Use the Attachmate Customization Tool to create transforms or companion installer packages. Each type of customization has its own set of configuration panels that display, depending on your choice from the **Select Customization** panel.

---

**Open the Attachmate Customization Tool**

You must first create an administrative install image before you can run the Attachmate Customization Tool.

---

**To open Attachmate Customization Tool**

Do one of the following:

- On a command line, change to the administrative installation point and enter:
  ```
  setup.exe /admin
  ```
  Or

- If you have set up a shortcut to ACT (page 74), double click the shortcut.

The Select Customization dialog box prompts you to choose which mode you want to open.

---

**Note:** You cannot run the Attachmate Customization Tool if you are currently running the Attachmate Installation Program; you can run only one instance of the `setup.exe` program at a time.
Set up a shortcut to ACT

By default, the Attachmate Customization Tool (ACT) can be opened only from a command line but you can create a desktop shortcut and set the shortcut properties to open this tool. Although creating this shortcut is optional, you will find that it saves time when you are working with ACT.

To set up a desktop shortcut that opens ACT

1. On your administrative installation point, right-click on the setup.exe file and choose Create Shortcut.
2. Right-click on the shortcut and choose Properties.
3. In the Target field, add the /admin option to the end of the command line. For example:
   ```bash
   \myServer\adminInstallPoint\setup.exe /admin
   ```
   CAUTION: Make sure the path in the Target field is referenced with a Uniform Naming Convention (UNC) format. Do not use drive letters in the path name. Using drive letters can cause problems when you try to use the shortcut on other workstations.
4. Rename the shortcut and save it on the desktops of your workstation and on the server that you are using for your administrative installation point.

Select a Customization Type

Once you've opened the Attachmate Customization Tool, you can create a transform, a companion install package, or open an existing file of either type.

To select a customization type

1. From the Select Customization dialog box, select a customization type:

<table>
<thead>
<tr>
<th>To do this</th>
<th>Select</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a new transform file (.mst)</td>
<td>Create a new Setup customization file for the following product (the default).</td>
</tr>
<tr>
<td>Create a new companion install package (.msi)</td>
<td>Create a new Companion installer.</td>
</tr>
<tr>
<td>Open an existing file of either type</td>
<td>Open an existing Setup customization file or Companion installer.</td>
</tr>
</tbody>
</table>

2. Click OK.

Creating and Editing Transforms

Using the Attachmate Customization Tool, you can create standard MSI transforms that modify the primary installer database. You can also open and edit existing .mst files that you have already created for this product using the Attachmate Customization Tool.
After you create the transform, you must include it in the install. Transforms can be used with any install started with setup.exe or with command-line installs (used by many deployment tools). The installer can only apply transforms during an installation.

Notes:

- To use a transform file with SETUP.EXE, from the User interface panel, select Use this customization with interactive installs using setup.exe. When you save your transform with this option selected, Attachmate Customization Tool automatically updates the SETUP.INI file to apply your transform to the Reflection X installation.

- To install the specified customization, you should save transform files in the same folder as the package file for Reflection X, and reference them during installation.

- For more information about creating and deploying transforms, see Technical Note 2369 (http://support.attachmate.com/techdocs/2369.html).

Supported modifications include:

- Install location

- User interface level — silent or interactive (requires setup.exe and setup.ini)

- Feature states, including hidden features

- Modification or removal of shortcuts

- Optional upgrades of older products

- Chaining of other installs, or execution of programs before or after the primary install (requires setup.exe and setup.ini)

- Modifying Windows Installer properties

Create Transforms

Customize Reflection X to specify the way you want it to install, look, and act on the end user’s computer.

To create an installation transform

1. On a workstation on which you have installed Reflection, open the Attachmate Customization Tool from a desktop shortcut (page 74) or from a command line as follows:

   `path_to_setup\setup.exe /admin`

2. Select Create a new setup customization file for the following product, and then click OK.

3. Select items from the list in the left panel to open configuration panels on the right, and then make your customizations.

4. From the File menu, choose Save As.
Transform files are saved as `.mst` files, and it is recommended that you save them in the same folder as the installer package file for Reflection X.

### To modify an existing installation transform

1. On a workstation on which you have installed Reflection, open the Attachmate Customization Tool from a desktop shortcut (page 74) or from a command line as follows:
   
   ```
   path_to_setup\setup.exe /admin
   ```

2. Select **Open an existing Setup customization file or Companion installer**, and then click **OK**.

3. In the **Open** dialog box, browse to the location you selected when you created your transform file, and select the `transform_name.mst` file.

4. Select items from the list in the left panel to open configuration panels on the right, and then make your customizations.

5. From the **File** menu, choose **Save As**.

   Transform files are saved as `.mst` files, and it is recommended that you save them in the same folder as the installer package file for Reflection X.

### Add (Chain) Installations and Run Programs

Reflection X makes it easy to "chain" installs. You can set up an install to run companion install packages automatically before or after the primary installation. You can also specify to run other scripts or programs.

---

**Note:** This method of "chaining" installations applies only to installs performed with Setup.exe. It does not apply to installs that use the MSI command line method.

---

### To chain installations and programs

1. On a workstation on which you have installed Reflection, open the Attachmate Customization Tool from a desktop shortcut (page 74) or from a command line as follows:
   
   ```
   path_to_setup\setup.exe /admin
   ```

2. Select **Create a new setup customization file for the following product**, and then click **OK**.

3. From the Attachmate Customization Tool navigation pane, select **User Interface** and then select **Use this customization with interactive installs using setup.exe**.

4. From the Attachmate Customization Tool navigation pane, choose **Add installations and run programs**.
5 Click **Add**.

The **Add/Modify Program Entry** dialog box opens.

6 In the **Target** list, enter or select the folder where the program .exe file or the .msi file resides, and then enter the executable to run; for example:

`msiexec.exe`

7 Under **Arguments**, enter the command-line arguments to execute; for example:

`/i my_installation.msi`

8 To specify when to run the program, select either **Run this program after base product has been installed**, or **Run this program before the base product has been installed**.

---

Note: For most cases, select **Run this program after the base product has been installed**. If you select **Run this program before the base product has been installed** and the program fails, Reflection X is not installed.

9 Repeat these steps to add other programs or MSI files.

10 To change the execution sequence, use the arrows next to **Move** (at the bottom left area of the pane); to remove a program from the list, select it in the list and click **Remove**.

### Select Features, Components, and Languages

You can select which features, components, and languages to install for your end users. In addition, you can choose from three levels of not installing an item: advertising it, not installing it, and permanently blocking it to prevent users from installing it later.

**To select features, components, and languages to install**

1 On a workstation on which you have installed Reflection, open the Attachmate Customization Tool from a desktop shortcut (page 74) or from a command line as follows:

   `path_to_setup\setup.exe /admin`

2 From the **Select Customization** dialog box, do one of the following:

   - Select **Create a new Setup customization file for the following product**.
   - Select **Open an existing Setup customization file or Companion installer** and, in the **Open** dialog box, select an .MST file.

3 From the Attachmate Customization Tool navigation pane, choose **Set Feature Installation States**.
4  Select the feature installation states as follows:

<table>
<thead>
<tr>
<th>Choose</th>
<th>To do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Feature will be installed on local hard drive</td>
<td>Add a feature to the installation.</td>
</tr>
<tr>
<td>Feature will be installed when required</td>
<td>Advertise a feature.</td>
</tr>
<tr>
<td>Feature will be unavailable</td>
<td>Leave a feature uninstalled. End users will still be able to select the item and install it from the Windows Uninstall or change a program list (or the Add/Remove Programs control panel in Windows XP).</td>
</tr>
<tr>
<td>Feature will be hidden from view</td>
<td>Leave a feature uninstalled and hidden. End users will not be able to install the item and it will not be visible in the Windows Uninstall or change a program list.</td>
</tr>
</tbody>
</table>

**Configure Shortcuts**

You can change the attributes associated with the pre-defined Reflection X shortcuts. Also, you can configure shortcuts associated with files you’ve added to a custom install package.

**To configure shortcuts**

1  On a workstation on which you have installed Reflection, open the Attachmate Customization Tool from a desktop shortcut (page 74) or from a command line as follows:

    {\textit{path_to_setup\setup.exe /admin}}

2  From the Select Customization dialog box, select the option that best describes the task you are performing.

3  From the Attachmate Customization Tool navigation pane, choose Configure shortcuts.

4  Select the shortcut that you want to configure, and then click Modify.
5. In the **Modify Shortcut** dialog box, enter the following settings:

<table>
<thead>
<tr>
<th><strong>To</strong></th>
<th><strong>Do this</strong></th>
</tr>
</thead>
</table>
| Specify where you want the shortcut to reside | In the **Location** list, enter or select the folder.  
Note: List items that refer to folders (for example, [ProgramMenuFolder]) are pre-defined folder keywords. You can create customized directories by adding new folder names with typical directory syntax (such as, [ProgramFilesFolder]\My Folder). Alternatively, you can enter a fully qualified path (for example, C:\Program Files\My Folder), as long as that location is known to exist on the target machine. |
| Name the shortcut | In the **Name** box, enter a descriptive name. |
| Add a tooltip to the shortcut | In the **Tooltip** box, enter descriptive text to describe the shortcut. |
| Pass command line arguments to the program | In the **Arguments** box, enter the command-line arguments. |
| Specify the size of the application window | In the **Run** list, select an initial size for the application window. |

### Apply a Transform to Your Installation

If you have created a transform to customize how Reflection X is installed, you will need to deploy the transform with the primary installation. Transforms can be used with any install started with `setup.exe` or with command-line installs (used by many deployment tools). The installer can only apply transforms during an installation.

#### To add the transform to an install started with `setup.exe`

1. On a workstation on which you have installed Reflection, open the Attachmate Customization Tool from a desktop shortcut (if you set up a shortcut as shown on page ) or from a command line as follows:

   ```
   path_to_setup\setup.exe /admin
   ```

2. In the **Select Customization** dialog box, select **Open an existing Setup customization file or Companion installer**, and then click **OK**.

3. In the **Open** dialog box, browse to the location you selected when you created your transform file, and select the transform (.mst) file.

4. From the **User interface** panel, select **Use this customization with interactive installs using setup.exe**.

   When you save your transform with this option selected, Attachmate Customization Tool automatically updates the SETUP.INI file to apply your transform to the Reflection installation by adding the following line to the [Setup] section in the SETUP.INI file:

   ```
   CustomTransform=<your_transform.mst>
   ```
From the **File** menu, click **Save**. (If Save is grayed out, click Exit and you will be prompted to save the file.)

The transform can now be deployed to end users via the `setup.exe` file. (Users can run `setup.exe` or the `setup.exe` file can be called from a script or initiated from a command line.)

### To add the transform to a setup.exe command-line install

- Alternately, you can add the transform to a command-line installation. Use the following command line syntax:

  `<path_to_setup>\setup.exe /install TRANSFORMS=transform.mst`

---

### Creating a Companion Install Package

Create a companion install package (also called a "companion database") to install any files that are not installed with Reflection X.

Because companion files are installed independently of Reflection X, you can upgrade the product without removing these support files. You can also deploy additional support files without re-installing the product. If, for example, you are supporting several business units that require their own customized configuration files, you can create a companion install package for each business unit.

Companion install packages support:

- Specification of files and installation directories.
- Shortcuts for selected files.
- Addition of custom application settings.
- Chaining with the primary installer (chaining must be specified in the .mst file).
- Removal without affecting the primary installs. (The primary install can also be removed without affecting the files added with a companion package.)

Companion install packages can be installed with any mechanism that supports MSI packages. The packages have no built-in user interface, other than the standard progress bar.

### Create a Companion Install Package

Create a companion install package (also called a "companion database") to install any files that are not installed with Reflection X.

#### To create a companion install package

1. On a workstation on which you have installed Reflection, open the Attachmate Customization Tool from a desktop shortcut (page 74) or from a command line as follows:

   `path_to_setup\setup.exe /admin`

2. From the **Select Customization** dialog box, select **Create a new Companion installer** (or open an existing MSI), and then click **OK**.
3 From the navigation pane, select **Specify package information**.

4 In the **Add/Remove name** box and the **Organization name** box, type a name for the installation and the publisher that you want to be displayed in the Microsoft Windows "Uninstall or change a program" panel.

Note: The Windows Vista and Windows 7 **Uninstall or change a program** list is similar to the Windows Add or Remove Programs List for previous versions of Windows. It is accessed by selecting Programs and Features from the Control Panel.

5 From the navigation pane, select **Specify install locations**.

6 Under **Installation type**, select whether to install the files for all users or for only one user:

<table>
<thead>
<tr>
<th>Select</th>
<th>To set up the companion installer package to</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Installs to all users of a machine</strong></td>
<td>Make files available for every user who logs onto the computer.</td>
</tr>
<tr>
<td><strong>Installs only for the user who installs it</strong></td>
<td>Use this option for settings files, macros, and other configuration files that you want to be available to all users.</td>
</tr>
</tbody>
</table>

**Important!** If you are deploying files that must be installed in the user's personal data folders, you must select this option.

7 In the **Default installation folder** list, select the folder in which to install the files. (Files are deployed to this folder unless you specify another folder when you add a file.)

Note: The folders available in this list depend on which Installation type you chose. **Installation Type** folder options specify the access for the files (after the installation). These options affect only the folders to which you can install — you cannot change these options after you add a file.

8 In the **Default shortcut folder** list, select the folder in which to install program shortcuts. (Shortcuts are deployed to this folder unless you specify another folder when you add a file.)

Note: List items that refer to folders (for example, [ProgramMenuFolder]) are pre-defined folder keywords. You can create customized directories by adding new folder names with typical directory syntax (such as, [ProgramFilesFolder]\My Folder). Alternatively, you can enter a fully qualified path (for example, C:\Program Files\My Folder), as long as that location is known to exist on the target machine.

Note: **Installation type** options specify the access for the files (after the installation). These options affect only the folders to which you can install — you cannot change these options after you add a file.

9 From the navigation pane, select **Add files** to add, update, or remove files or shortcuts.

You can also modify setup properties or user settings for the companion installation.
When you have finished creating your companion package, you can deploy it by itself or with Reflection X. The package remains on the end user’s computer until it is removed with the Microsoft Add/Remove Programs utility.

**Add Files to a Companion Installer**

You can add or remove files and shortcuts to or from a companion install package.

**To add a file to the companion installer**

1. On a workstation on which you have installed Reflection, open the Attachmate Customization Tool from a desktop shortcut (page 74) or from a command line as follows:

   ```
   path_to_setup\setup.exe /admin
   ```

2. From the Select Customization dialog box, select Create a new Companion installer (or open an existing MSI), and then click OK.

3. From the navigation pane, select Specify install locations.

4. Under Installation type, specify either Installs to all users of a machine or Installs only for the user who installs it.

5. From the navigation pane, select Add files.

6. Under Add files to, specify a destination location for the file. You can choose a location from the list or edit the path by typing.

7. (Optional) To create a shortcut for the file, select Include shortcut.

8. Click Add, browse to locate the file you want to add to the installation, and then click Open.

**Add a Companion Installer to your Installation**

You can use this procedure to add one or more custom installer packages to your product installation.

**To add a companion package to your installation**

1. On a workstation on which you have installed Reflection, open the Attachmate Customization Tool from a desktop shortcut (page 74) or from a command line as follows:

   ```
   path_to_setup\setup.exe /admin
   ```

2. Select Create a new setup customization file for the following product, and then click OK.

3. From the navigation pane, click Add installation and run programs.

4. Click Add.

   The Add/Modify Program Entry dialog box opens.

5. In the Target list, browse to select your companion .msi file.
Deploying with the Windows Installer

6 Select **Run this program after the base product has been installed**.

7 Click **OK**.

8 Click **File > Save As** to save your transform.

---

**Note:** When you save your transform, the Customization Tool automatically updates the Setup.ini file, adding a [RunPrograms] section with instructions for installing your companion package.

9 Instruct users to install using **Setup.exe**.

The companion package is automatically installed after the installation is complete.

**Deploying Reflection X**

On Windows systems, you can use any of the following methods to deploy Reflection X from an administrative installation.

- Assign and publish with Active Directory (page 83)
- Deploy with Systems Management Server (page 84)
- Perform a silent installation from the command line

**Assign and Publish with Active Directory**

You can assign and publish your product installation using Microsoft Active Directory.

---

**Note:** Before you start, make sure that:

- Windows Administrative Tools are installed on your workstation.
- You are a member of Domain Admins and Group Policy Creators and Owners (required to publish software).

For more information, see "Assigning applications" and "Publishing applications" in the Microsoft Management Console help.

**To install with Active Directory**

1 From the **Active Directory User and Computers Console**, advertise your product installation to members of any organizational units in your Active Directory using appropriate transform modifications.

2 If multiple transforms are specified, make sure the listed order of the transforms is correct, and then click **OK**. (If you need to change the order for any reason after you click **OK**, you will have to start over again.)

---

**Note:** For more information about assigning and publishing, see "Assigning applications" and "Publishing applications" in the Microsoft Management Console help.
**Deploy with Systems Management Server**

You can deploy Reflection X with Microsoft Systems Center Configuration Manager (or Microsoft Systems Management Server).

---

**Note:** Before you start, make sure that:

- You are using SMS version 1.2 or later (SMS versions earlier than 1.2 are not supported).
- Microsoft Windows Installer software version 2.0 or later is installed on your computer, and on all of the computers on which you are installing the product.

---

**To deploy with System Center Configuration Manager**

1. Create an administrative install image on your site server. This serves as the administrative installation point for deployment.

2. Use the product Package Definition File (*.sms) to create the product installation package.

   **Note:** The Package Definition File (*.sms) is created during the administrative installation and can be found at the root of the administrative installation point. Alternatively, you can reference the .msi file directly — consult the Microsoft SMS documentation for more information.

3. Advertise the installation packages to your users.
Distributing Sessions with the Administrative WebStation

In this Chapter

Configure Sessions using the Administrative WebStation 85
The Reflection for the Web Security Proxy 87
Administrative WebStation Mode 87
WebStation User Mode 88
Save Settings (Administrative WebStation Mode) 88
Discard Settings (WebStation User Mode) 88

If you have installed Reflection for the Web and configured the Reflection Management Server, you can use the Reflection Administrative WebStation to administer Reflection X Advantage sessions. Check with Attachmate technical support to confirm that you have an appropriate version of Reflection for the Web 2011 for this feature.

This allows you to connect through the Reflection for the Web security proxy server, which provides SSL/TLS encryption to the proxy. The proxy server can also restrict the visibility of your hosts over the network, which enables you to limit host access to authorized users and members of LDAP groups.

Configure Sessions using the Administrative WebStation

Before you begin

- Install X Manager (standalone) on administrator and user computers. These must be Windows systems.
- Install the Reflection Management Server on the web server as shown in your Reflection for the Web documentation.
- Make sure you have administrative credentials for the Reflection Management Server.
To deploy a session with the Administrative WebStation

1. Install PKI Services Manager and configure it to validate the Reflection for the Web Security Proxy token certificate:
   - If you've obtained a certificate for the Security Proxy from a Certification Authority (CA), add the CA certificate to the PKI Services Manager trusted root store.
   - If you're using the proxy's default self-signed certificate, add this certificate to the PKI Services Manager trusted root store. To obtain a copy of the default certificate, start the Security Proxy Wizard, and go to Security Proxy Certificates > Export.

   Note: No Identity mapping is required for validating the Security Proxy certificate.

2. In a Web browser, launch Reflection for the Web as an administrator, and then click Administrative WebStation.

3. In the Administrative WebStation navigation pane, select Session Manager.

4. In the Session Manager, click Add to open the Add New Session page.

5. In the Add New Session page, select X Advantage, enter a session name, and click Continue.

6. By default Start X Manager in notification area of taskbar is enabled. With this option (recommended) X clients are launched on user desktops and X Manager runs in the background on the user's machine. Users see only the clients that are configured to open at startup.

7. In X Manager Preferences, make your selection for FIPS mode. Select this checkbox to enable FIPS, which enforces the United States government Federal Information Processing Standard (FIPS) 140-2 for this session.

8. Add any comments that you want to have available for review in the Administrative WebStation.

9. Click Launch. This launches X Manager in Administrative WebStation mode (page 87).

10. Configure a session and add the clients that you wish to make available to your end users.

11. Configure the security proxy options for each client using the Proxy tab on the Advanced Secure Shell Settings dialog box.

12. Go to Tools > Secure Shell Host Keys > PKI Configuration.

   - For PKI server, enter the name of the computer running PKI Services Manager.
   - Click Download key and click Yes to accept the key.

13. Test your connection. In response to the Host Key Unknown prompt, click Always. This adds the key to the known hosts lists in the configuration you save to the web server so users won't see the prompt.

   Note: The option to save a host key by selecting Always is not available for sessions running in WebStation User Mode.

14. Go to File > Exit. Click Save/Exit to close your session and save the configuration to the Reflection for the Web Administrative WebStation.
From the Reflection for the Web Administrative WebStation, map access for your users.

**The Reflection for the Web Security Proxy**

To distribute sessions with the Administrative WebStation, you must configure Reflection X sessions to connect through the Reflection for the Web security proxy server. Refer to the Reflection for the Web documentation for information on setting up a security proxy server. This provides SSL/TLS encryption to the proxy, and restricts network access to your hosts to users and members of LDAP groups that have been authorized by an administrator.

**Administrative WebStation Mode**

When you launch Reflection X from the Reflection for the Web Administrative WebStation, the title bar displays *X Manager- Administrative WebStation Mode*.

You can edit the settings for session and the server, and you can add X clients for your users.

When X Manager is launched in this mode, there are limitations on what you can do:

- Only one session is available. The session can include multiple clients.
- You can create clients so that they are available for your users. They cannot change the saved client settings, and they cannot save new clients.
- XDMCP is not supported as an option for **On session start/reset**.
- **SSH** is the only connection method available for clients. A security proxy server must be configured for each client.
- Changes you make to the session, the server, or to clients are not saved until you exit X Manager.
- When you close X Manager, you will be prompted to save your settings. Click **File > Exit**, and then click **Save/Exit** on the **Save Settings** dialog box. This saves your settings on the Reflection for the Web Management Server. If you have just created the session, you will be prompted in the Administrative WebStation to map the session so that it is available to users.
- You cannot modify FIPS mode. The setting for FIPS is configured when the session is deployed in the Administrative WebStation.

---

**Note:** If you do not see the FIPS configuration option in the Reflection Administrator, contact Technical Support for the appropriate upgrade.
WebStation User Mode

If you open X Manager after launching a session from the Links list of a Reflection for the Web management server, the title bar displays X Manager- WebStation User Mode.

- When you launch an X Manager session in this mode, you will have access to the session created by the administrator, which may include one or more clients.

- You can add clients to the X Manager session, but they will not be saved as part of the session and will not be available the next time the session is launched from the Links list. You can, however, export the clients for later use.

- Depending on how the session has been configured by the administrator, clients may start automatically or be started by users as needed. To manually start a client, the user can right-click on the client definition in X Manager and select Run. If X Manager runs in the notification area of the taskbar (the default), the user must select the Show X Manager taskbar option to start a client manually.

Save Settings (Administrative WebStation Mode)

When you launch a Reflection X session from the Reflection for the Web Administrative WebStation, you are opening X Manager in Administrative WebStation mode. You can configure the session, and add clients.

- **Save/Exit** Any changes you have made to this session will be saved. After mapping access to the session in the Administrative WebStation, the session will be available to users when they select it from the Reflection for the Web Links list.

- **Discard** Any changes you have made within this session will be discarded.

- **Cancel** Return to the session without exiting.

Discard Settings (WebStation User Mode)

When you launch a Reflection X session from the Links list of a Reflection for the Web management server, the clients created for this session by the administrator are available to you. You can add clients if you open X Manager in user mode, but they will not be available the next time the session is launched from the Links list. You can export the clients if you wish to retain them for import when you open the session again.

Click **Discard** to exit X Manager. Any changes you have made will not be saved. Click **Cancel** to return to the session without exiting, then select **File > Export** if you wish to save your changes by exporting them.
CHAPTER 9

Using PKI Services Manager with Reflection X

In this Chapter

Setting up PKI Services Manager on Windows 90
Setting up PKI Services Manager on UNIX 94
Configure Reflection X to Connect to PKI Services Manager 97

Reflection PKI Services Manager is a service that provides X.509 certificate validation services. If you configure Secure Shell connections to X client hosts that authenticate using certificates, you need to download and install this application. It is available at no additional charge.

- Reflection PKI Services Manager is required for Secure Shell connections that use certificates for host authentication. (It is not required for user authentication with certificates.)

- Reflection PKI Services Manager is required if you configure connections using the Reflection for the Web Administrative WebStation. For these connections PKI Services Manager validates the Security Proxy's certificate.

- Reflection PKI Services Manager is supported on both Windows and UNIX platforms.

- Reflection PKI Services Manager supports central management of PKI settings. You can install and configure a single instance of PKI Services Manager to provide certificate validation services for all supported Attachmate products. (Because Reflection X settings allow only one entry for the PKI Services Manager address and port, this configuration creates a potential single point of failure. If PKI Services Manager is unreachable or the server is not running, all authentication attempts using certificates will fail. In order to provide load balancing and failover, you can define a round-robin DNS entry for the PKI Services Manager host name or place the PKI Services Manager host behind a load balancing server.)

- You can run Reflection PKI Services Manager on the same host as a Reflection X domain controller or on a different host.

This user guide provides basic information about installing PKI Services Manager and configuring Reflection X to use it for certificate validation services. For additional information, refer to the PKI Services Manager documentation at http://support.attachmate.com/manuals/pki.html.

How it Works

1. The X client host presents a certificate to Reflection X Advantage for host authentication.

2. Reflection X connects to Reflection PKI Services Manager and verifies its identity using an installed public key.

3. Reflection X sends the certificate and host name to PKI Services Manager.
PKI Services Manager determines if the certificate is valid and uses mapping rules to determine whether the host is allowed to authenticate with this certificate.

If the certificate is valid and the host presenting it is an allowed identity for this certificate, Reflection X validates the host's digital signature. If the digital signature is verified, host authentication is successful.

Setting up PKI Services Manager on Windows

Install and Uninstall PKI Services Manager on Windows

Reflection PKI Services Manager is a service that provides X.509 certificate validation services. If you configure Secure Shell connections to X client hosts that authenticate using certificates, you need to download and install this application. It is available at no additional charge. Use this procedure to install Reflection PKI Services Manager on Windows systems.

Note: Reflection PKI Services Manager supports central management of PKI settings. You can install and configure a single instance of PKI Services Manager to provide certificate validation services for all supported Attachmate products.

To install Reflection PKI Services Manager

1 Log in as an administrator.

2 Start the Attachmate Installation Program (Setup.exe). If you are installing from the download site, the following steps start this program:
   a) From the download site, click the Windows download link and run the download program.
   b) Select a location for the installer files, and then click Next. This extracts the files to the specified location and starts the Attachmate Installation Program.

3 Accept the default settings on the Advanced tab. (Creating an administrative installation image does not actually install the product — instead, it places the install files on a network location for later installation to multiple workstations.)

4 Start the service (page 93).
Notes:

- On Windows, starting the console or the service for the first time initializes PKI Services Manager. This creates the required data folders and default settings files. If these folders already exist, they are not changed; PKI Services Manager uses your existing data files and folders. (On UNIX the install script automatically initializes PKI Services Manager if required, and starts the service.)

- Before Reflection PKI Services Manager can validate certificates you need to edit the default configuration and map files.

To uninstall Reflection PKI Services Manager

1. Log in as an administrator.

2. From the Windows Programs and Features (or the Add or Remove Programs) control panel, select Attachmate Reflection PKI Services Manager.

3. Click Uninstall (or Remove).

Configure PKI Services Manager on Windows

To configure client host authentication using certificates, you need to install and configure Reflection PKI Services Manager. Use the following procedure to get started. Many variations are possible. For more information about each of the steps below, see the Reflection PKI Services Manager User Guide, which is available from the PKI Services Manager console, and from http://support.attachmate.com/manuals/pki.html.

Before you begin:

- Install PKI Services Manager (page 90).

- Determine which trusted CA certificate and intermediate certificates are needed to validate the certificate that will be presented by the host you are connecting to. PKI Services Manager can use certificate files that you copy to your system, or trusted root certificates installed to the Windows certificate store for use by the local computer.

- Determine how certificate revocation checking should be handled for the host certificate. You can configure PKI Services Manager to use CRL lists, OCSP responders, or to contact a CRL distribution point specified within the certificate.

To configure PKI Services Manager

1. Log in as an administrator on the computer running PKI Services Manager.

2. Start the PKI Services Manager console:

   Programs > Attachmate Reflection > Utilities > PKI Manager
3. Put a copy of the certificate you want to designate as a trust anchor into your local store. The default PKI Services Manager store is in the following location:

```
common application data folder\Attachmate\ReflectionPKI\local-store
```

(This step is not required if you are using certificates in the Windows store or you have a copy of the trust anchor available somewhere else on your system.)

4. From the **Trusted Chain** pane, add your trust anchor (or anchors) to the list of trust anchors.

<table>
<thead>
<tr>
<th>To use this store</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Your local certificate store or a certificate file on your system</td>
<td>Click <strong>Add</strong>. Select either <strong>Local store certificate</strong> or <strong>Certificate file</strong>, click <strong>Browse</strong> and select the certificate for your trust anchor.</td>
</tr>
<tr>
<td>The Windows certificate store</td>
<td>Under <strong>Search order to use when building path to trust anchor</strong>, select &quot;Windows certificate store.&quot; Click <strong>Add</strong>. From the <strong>Add Trust Anchor</strong> dialog box, select <strong>Windows certificate</strong> then click <strong>Browse</strong> to select an available certificate. Note: PKI Services Manager uses only those certificates that are installed for use by the local computer (not certificates installed for the current user) and are in either the trusted root certification authorities list or the trusted intermediate authorities list. To view and manage the local computer certificates, use the Microsoft Management Console. Add the Certificates Snap-in and configure it to manage certificates for the computer account.</td>
</tr>
</tbody>
</table>

5. From the **Revocation** pane, configure certificate revocation checking.

Note: By default PKI Services Manager looks for CRLs in the local store. If you use this configuration, you need to copy the CRLs to your local store.

6. From the **Identity Mapper** pane, click **Add** to determine which client hosts can authenticate with a valid certificate.

For example, to allow client hosts to connect if the host name is specified in the Common Name value of the certificate's Subject field:

- Set **Select type of certificate that is to be mapped** to Host Certificate
- Click the drop-down arrow for **Choose certificate identity to insert** and select Subject Common Name.

Refer to the PKI Services Manager documentation for additional information about mapping rules.

7. Click **File > Save**.

8. Start the PKI Services Manager service (page 93) if it isn't already running. If the service is already running, reload your settings (**Server > Reload**).
Start and Stop the PKI Services Manager Service on Windows

Note: The PKI Services Manager service starts automatically when you restart Windows.

**To start the service**

- From the PKI Services Manager console, click **Server > Start**.
- or-
- From a DOS command window, enter the following command:
  
  `winpki start`
- or-
- Open the Windows Services console (Control Panel > Administrative Tools > Services), select Attachmate Reflection PKI Services Manager and click Start.

**To stop the service**

- From the PKI Services Manager console, click **Server > Stop**.
- or-
- From a DOS command window, enter the following command:
  
  `winpki stop`
- or-
- Open the Windows Services console (Control Panel > Administrative Tools > Services), select Attachmate Reflection PKI Services Manager and click Stop.

**To check the service status**

- Start the PKI Services Manager console and look for status information on the status line at the bottom of the console window.
- or-
- From a DOS command window, enter the following command:
  
  `winpki ping`
- or-
- Open the Windows Services console (Control Panel > Administrative Tools > Services) and view the status of Attachmate Reflection PKI Services Manager.
Setting up PKI Services Manager on UNIX

Use this information to install, uninstall, and configure PKI Services Manager on UNIX.

Install and Uninstall Reflection PKI Services Manager on UNIX

Reflection PKI Services Manager is a service that provides X.509 certificate validation services. If you configure Secure Shell connections to X client hosts that authenticate using certificates, you need to download and install this application. It is available at no additional charge. Use this procedure to install Reflection PKI Services Manager on UNIX systems.

To install Reflection PKI Services Manager

1. Log in as root.
2. Copy the installation package file to your computer and navigate to the directory that contains this file.
3. Use gzip to unzip the package:
   
   gzip -d package_name.tar.gz
   
   For example:
   
   gzip -d pkid_1.2.0.999-i386-solaris.gz

4. Use tar to expand the file:
   
   tar -xf package_name.tar
   
   This creates a directory based on the package name. For example:
   
   pkid_1.2.0.999--i386-solaris/

5. Change to this directory. For example:
   
   cd pkid_1.2.0.999-i386-solaris

6. Run the install script:
   
   ./install.sh

7. You are prompted to specify installation locations. To accept the default locations (recommended), press Enter in response to these prompts.

Notes:

- On UNIX the install script automatically starts the service.
- Before Reflection PKI Services Manager can validate certificates you need to edit the default configuration and map files.
Using PKI Services Manager with Reflection X

To uninstall

1. Log in as root.

2. Run the uninstall script. This script is installed to the bin directory in the PKI Services Manager data folder. The default path is:

   /opt/attachmate/pkid/bin/uninstall.sh

---

**Note:** The uninstall script renames your existing configuration directory (\*opt/attachmate/pkid/config/\* by default) using a name based on the current date, and time. For example, config.20110101143755. Your local-store directory and any certificates you have added to this directory remain unchanged.

---

Configure PKI Services Manager on UNIX

To configure client host authentication using certificates, you need to install and configure Reflection PKI Services Manager. Use the following procedure to get started. Many variations are possible. For more information about each of the steps below, see the Reflection PKI Services Manager User Guide, which is available from the PKI Services Manager console, and from http://support.attachmate.com/manuals/pki.html.

Before you begin:

- Install PKI Services Manager (page 94).
- Obtain the trusted CA certificate and any intermediate certificates that are needed to validate the certificate that will be presented by the host you are connecting to.
- Determine how certificate revocation checking should be handled for the host certificate. You can configure PKI Services Manager to use CRL lists, OCSP responders, or to contact a CRL distribution point specified within the certificate.

**To configure PKI Services Manager**

1. Log in as root on the Reflection PKI Services Manager server.

2. Install Reflection PKI Services Manager.

3. Put a copy of the certificate you want to designate as a trust anchor into your local store. The default PKI Services Manager store is in the following location:

   /opt/attachmate/pkid/local-store

4. Open the PKI Services Manager configuration file in a text editor. The default name and location is:

   /opt/attachmate/pkid/config/pki_config

5. Use the **TrustAnchor** keyword to identify your trust anchor. For example:

   TrustAnchor = trustedca.crt

   -or-

   TrustAnchor = CN=SecureCA,O=Acme,C=US
Note: To configure multiple trust anchors, add additional TrustAnchor lines.

6 Configure certificate revocation checking. For example:

<table>
<thead>
<tr>
<th>To</th>
<th>Sample Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use CRLs stored on an LDAP server.</td>
<td>RevocationCheckOrder = crls-server</td>
</tr>
<tr>
<td></td>
<td>CRLServers=ldap://crlserver</td>
</tr>
<tr>
<td>Use an OCSP responder.</td>
<td>RevocationCheckOrder = ocsp</td>
</tr>
<tr>
<td></td>
<td>OCSPResponders = <a href="http://ocspreponder">http://ocspreponder</a></td>
</tr>
</tbody>
</table>

Note: By default PKI Services Manager looks for CRLs in the local store. If you use this configuration, you need to copy the CRLs to your local store.

7 If intermediate certificates are required by the chain of trust in your certificates, configure access to these certificates. For example:

<table>
<thead>
<tr>
<th>To</th>
<th>Sample Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use intermediate certificates you have added to your local store.</td>
<td>CertSearchOrder=local</td>
</tr>
<tr>
<td>Use certificates stored on an LDAP server.</td>
<td>CertSearchOrder=certserver</td>
</tr>
<tr>
<td></td>
<td>CertServers=ldap://ldapserver</td>
</tr>
</tbody>
</table>

8 Save your changes to the configuration file.

9 Open the PKI Services Manager map file in a text editor. The default name and location is:

    /opt/attachmate/pkid/config/pki_mapfile

10 Add one or more rules to determine which client hosts can authenticate with a valid certificate. For example, to allow client hosts to connect if the host name is specified in the Common Name value of the certificate's Subject field:

    RuleType = host
    {acme.com}

11 Test for valid PKI Services Manager configuration:

    /usr/local/sbin/pkid -k

    No errors. Configuration is valid:

12 Restart Reflection PKI Services Manager.

    /usr/local/sbin/pkid restart
Start and Stop the Service on UNIX

The PKI Services Manager service starts automatically after installation. A script is installed, which you can use to start, stop, restart, and check the status of the service.

Note: The following procedures use the installed `pkid` script (`/etc/init.d/pkid`). For additional options available using the `pkid` daemon (`/usr/local/sbin/pkid`), see PKI Services Manager Command Reference or refer to the manual page: `man pkid`

To start the service

```
/etc/init.d/pkid start
```

To stop the service

```
/etc/init.d/pkid stop
```

To check the service status

```
/etc/init.d/pkid status
```

Configure Reflection X to Connect to PKI Services Manager

Reflection X needs to connect to Reflection PKI Services Manager for host certificate verification. The procedure for configuring this connection depends on whether you are running in standalone or domain mode.

- In standalone mode, use X Manager to configure the connection to PKI Services Manager. This connection must be configured individually on each computer running X Manager.

- In domain mode, you need to use the Administrative Console to configure the connection to PKI Services Manager. This enables you to configure the connection once for all domain users. The connection information is used for all Secure Shell client connections in the domain that require host certificate authentication.

To configure X Manager to connect to PKI Services Manager

1. Start X Manager.

2. From the Tools menu, click Secure Shell Host keys.

3. Click the PKI Configuration tab.
4 For **PKI server**, specify the host name or IP address of the computer running PKI Services Manager. (You can specify `localhost` if you’re running X Manager and PKI Services Manager on the same computer.)

Note: If PKI Services Manager is configured to use a non-default port, include the port value using `hostname:port` syntax. For example `acme.com:18081`.

5 Click **Download key**. This retrieves the public key from the specified PKI server and displays a dialog box that allows you to confirm this identity. To compare the presented fingerprint with the actual PKI Services Manager key open the PKI Services Manager console on the PKI server, and go to **Utility > View Public Key**.

When you click **Yes** to accept the key, the key is imported into the Reflection X database.

---

To configure a X Manager for Domains to connect to PKI Services Manager

1 Start the Administrative Console.

2 Click the **Domain Composition** tab.

3 For **PKI server**, specify the host name or IP address of the computer running PKI Services Manager. (You can specify `localhost` if you’re running the Reflection X domain controller and PKI Services Manager on the same computer.)

Note: If PKI Services Manager is configured to use a non-default port, include the port value using `hostname:port` syntax. For example `acme.com:18081`.

4 Click **Download key**. This retrieves the public key from the specified PKI server and displays a dialog box that allows you to confirm this identity. To compare the presented fingerprint with the actual PKI Services Manager key open the PKI Services Manager console on the PKI server, and go to **Utility > View Public Key**.

When you click **Yes** to accept the key, the key is imported into the Reflection X database.
Glossary of Terms

An X Keysym is an encoding of a symbol on the cap of a key. The set of defined X Keysyms includes the ISO Latin character sets, Katakana, Arabic, Cyrillic, Greek, Technical, Publishing, APL, Hebrew, Thai, Korean, and other keys found on keyboards such as Return, Help, and Tab.

A list of X Keysyms is associated with each keycode. The list is intended to convey the set of symbols on the corresponding key. Standard rules for obtaining an X Keysym from a KeyPress event make use of only the first four X Keysyms associated with a keycode. Depending on the state of the Shift and ModeSwitch (AltGr) modifiers, one of the first four keysyms will be selected.

**bandwidth**

The rate of transmission of data across the network; the maximum amount of information (Kbits/second or Mbits/second) that can be transmitted along a channel.

**client connector**

Accepts incoming connection requests from X clients and forwards X protocol requests received from the X client to the protocol router. The client connector also receives X protocol replies, events, and errors from the protocol router and forwards these to the appropriate X client.

**client definition**

Contains configuration information for starting one or more X client applications on a host. In previous versions of Reflection X, a client definition was called a client file (.rxc).

**compressor**

Compresses X protocol messages, sends them across the network, decompresses them, and forwards them.

**controlling X server**

The X server in a session that has control of keyboard and mouse input.

**definition**

A set of related settings used to configure some aspect of a session. Definitions are stored locally or in a domain. Major types of definitions include client definitions, server definitions, and session definitions.

**definition file**

Definition files (*.rxd) contain Reflection X Advantage configuration information in XML format. This file format is used to export and import settings to and from Reflection X Advantage.
**distributed X session**

An X session whose session components are running on more than one computer.

**domain**

A Reflection X domain consists of one or more computers on which X session components are run and load-balanced. The domain also defines a group of users who can run and share X sessions on those computers.

**domain controller**

This term applies to the computer that runs the domain controller software component, and is responsible for:

- Providing a way for domains and their domain nodes to locate each other.
- Giving domains the ability to start or stop session components on various domain nodes.
- Authenticating users before granting access to the domain.
- Centralized storage of settings.

**domain node**

A computer on which Reflection X is installed that an administrator has included in a Reflection X domain.

**headless X server**

A special type of X server that has no display. It maintains display contents in memory and serves to keep a session *alive* when no other X servers are connected. It can also provide short-circuiting of certain X protocol requests.

**IME (Input Method Editor)**

An input method editor is an application that allows you to enter characters and symbols that are not available on your keyboard.

**internal authentication**

A proprietary authentication system that can be used by Reflection X Advantage to grant users access to domain features. If the domain is configured to use internal authentication, Reflection X maintains an internal database of the user names/passwords that are authorized by the system.

**JVM**

Java Virtual Machine. A virtual machine that interprets and executes Java bytecode. Because Reflection X Advantage is a Java application, a JVM must exist on every machine that runs Reflection X Advantage.
**keycode**

In the X Window System, every individual, physical key is associated with a number in the range 8–255, called its keycode. A keycode only identifies a key, not a particular character or term among the ones that may be printed on the key.

**latency**

The time delay between when an action is initiated and when its effect is detectable. In a network, a delay in the reception of data packets can be caused by several factors, such as the transmission medium, and the number of network devices between the sending and receiving points. In general, the greater the physical distance between your workstation and your host, the greater the chance of encountering latency.

**Log files**

Reflection X log files are created for a variety of applications and services.

**Applications:** X Manager, X Manager for Domains, Administrative Console, rxsconfig, and rxmigrate

**Services:** Reflection X Service, Domain Controller, Domain Node

The log files all have a .log extension. Their locations vary by platform.

**PKCS**

PKCS (Public Key Cryptography Standards) is a set of standards devised and published by RSA laboratories that enable compatibility among public key cryptography implementations. Different PKCS standards identify specifications for particular cryptographic uses. Reflection X uses the following PKCS standards:

- PKCS#5 is used to provide password-based encryption for private keys stored in the Reflection X database.
- PKCS#11 provides support for authentication using hardware devices, such as smart cards or USB tokens.
- PKCS#12 is used for storage and transportation of certificates and associated private keys. Files in this format typically use a *.pfx or *.p12 extension. Reflection for Secure IT supports authentication using certificates and keys stored in this format.

**private definition**

Configuration settings (for either a server, a client, or a session) that can only be viewed and used by the user who created it. A private definition is read-write for the user who created it.

**protocol router**

Receives X protocol requests from client connectors and forwards them to all of the X servers in the session. It synchronizes the processing of requests and device events to ensure that all the X servers in the session remain in identical states.
public definition

Configuration settings (for either a server, a client, or a session) that an administrator has made available to users in a domain. A public definition is read-write for the administrator and read-only for all other users.

Reflection X Service

A service (or daemon) on a computer that can be configured as a domain controller, domain node, and/or support remote session services. (The services supported depend on which features you installed (page 16).)

remote session

In a remote session, the Reflection X session processes (the client connector and protocol router) run on a different computer than X Manager or X Manager for Domains.

server definition

The configuration settings for an X server. You can create a server definition yourself or you can clone an existing one (such as Generic X Server) and use it as a starting point for a new one.

session

Consists of several running components (client connectors, a protocol router, and X server(s)) that were configured from a session definition. A session may or may not have X client applications connected to it. All X server displays associated with a session display the same clients; a session may be shared by several users.

session definition

A combination of session settings, an X server definition and, optionally, one or more client definitions. When a session definition is launched, a session is created.

standalone X session

An X session whose components are running on a single computer, in the same JVM.

suspended X session

A running X session that does not have an X server display currently associated with it. When a user leaves a session, its display state is maintained in memory on a member node within the domain.
**X Administrative Console**

X Administrative Console is a management tool for configuring and managing Reflection X Advantage domains. You can use it to control user access to a domain; share session, client, and server definitions; configure load balancing; and monitor sessions.

**X Keysym**

An X Keysym is an encoding of a symbol on the cap of a key. The set of defined X Keysyms includes the ISO Latin character sets, Katakana, Arabic, Cyrillic, Greek, Technical, Publishing, APL, Hebrew, Thai, Korean, and other keys found on keyboards such as Return, Help, and Tab.

A list of X Keysyms is associated with each keycode. The list is intended to convey the set of symbols on the corresponding key. Standard rules for obtaining an X Keysym from a KeyPress event make use of only the first four X Keysyms associated with a keycode. Depending on the state of the Shift and ModeSwitch (AltGr) modifiers, one of the first four keysyms will be selected.

**X Manager**

A Reflection X tool that allows you to configure and launch X sessions locally, and permits session sharing. It does not use a Reflection X domain; nor does it allow users to leave and rejoin sessions.

**X Manager for Domains**

An application that connects to a Reflection X domain storing session definitions in a database. X sessions run locally, or on domain nodes, which support fault tolerance and protocol compression. It permits session sharing, and allows users to leave and rejoin sessions.

**X server**

The session component that provides a visual display. The controlling X server also manages input devices, such as keyboard and mouse.

**X server display**

An X server with a visual display or "viewer," as opposed to a headless X server, which has no display.

**X session**

See session (page 102).

**XDMCP**

X Display Manager Control Protocol.
**XDMCP broadcast**

The X server performs a UDP broadcast in order to locate hosts.

**XDMCP direct**

The X server sends a request to the X display manager program running on a specific host. You must enter the host name or IP address in the **Host name** text box.

**XDMCP indirect**

The X server contacts another computer to perform a UDP broadcast in order to locate XDM hosts. You must enter the host name or IP address of this other computer in the **Host name** text box.

**XIM server**

XIM (X Input Method) is an X11 protocol that supports composed character input. The XIM server provided by Reflection X can obtain composed text from an IME running on the Reflection X workstation and pass this text to XIM-aware X clients. (Reflection X does not support passing composed text to other input methods that may be provided by your operating system, such as XIMP and SCIM.)
Index

A
Active Directory  83
  assign and publish  83
adding
  domain nodes  48
  user accounts  55
Administrative Console  39
administrative installation
  Advanced tab (installer)  13
  create an installation image  72
Advanced tab (installer)  13
Attachmate Customization Tool
  creating and editing transforms  74
  how to open  73
  select a customization type  74
authentication
  about domain access  52
  configure and test  53
  configuring Internal  55
  configuring LDAP  54
B
bandwidth
  defined  99
C
chain installations  76
companion installer
  add files  82
connecting
  configure a Secure Shell connection  28
customize the installation
  add files to an installation  82
  Attachmate Customization Tool  73
  creating and editing transforms  74
  select features  77
D
deployment
  Active Directory  83
domain nodes  48
  adding nodes  48
  configure domain nodes  48
  removing nodes  49
domains
  about  45
  authentication  52
  components  39
  configurations
    domain setup
      centralize session configuration  63
      improve performance over a slow network  57
      leave and rejoin sessions  60
domain access  52
sample configurations  57
setup domain controller  45
unlocking  56
F
Feature Selection tab  13
figures
  basic session
    standalone X Manager  38
    X Manager for Domains  40
distributed session
  standalone X Manager  38
  X Manager for Domains  41
domain setup
  centralize session configuration  63
  improve performance over a slow network  57
  leave and rejoin sessions  60
I
icons  32
illustrations
  basic session
    standalone X Manager  38
    X Manager for Domains  40
distributed session
  standalone X Manager  38
  X Manager for Domains  41
domain setup
  centralize session configuration  63
  improve performance over a slow network  57
  leave and rejoin sessions  60
IME (Input Method Editor)
  defined  100
Reflection X Advantage

installation
  deploy to Windows workstations 69
  feature selection 16
  how to install 14
  Mac 15
  planning a domain 45
  requirements 11
  upgrade and migration 17
  Windows 11
installation, customizing
  add files to an installation 82
  Attachmate Customization Tool 73
  creating and editing transforms 74
  select features 77
Internal Authentication
  configuring Internal 55

L
latency
  defined 101
  improve performance in slow networks
    domains 57
LDAP authentication
  configuring LDAP 54
log on to a domain
  unlock domain 56

M
migrating to Reflection X Advantage
  migrating settings 18
  upgrade and migration 17

N
nodes
  domain node setup 48

O
Operating systems, supported 11

P
password, lost 56
Performance
  improve performance in slow networks
    domains 57
PKI Services Manager
  about 89
  configure Reflection X to use 97
install on UNIX 94
install on Windows 90
set up on UNIX 94
set up on Windows 90

R
recovery script 56
Reflection X Service
  features 39
  installing 16
  planning a domain 45
  starting and stopping 46
removing Reflection X 25
requirements 11

S
Secure Shell
  configure a Secure Shell connection 28
session distribution
  basic session
    standalone X Manager 38
    X Manager for Domains 40
distributed session
  standalone X Manager 38
  X Manager for Domains 41
  improve performance in slow networks
    domains 57
Session persistence
  configure 51
sessions
  components 37
Sessions
  about session definitions 34
  shortcuts
    to a custom installation 78
SMS 84
Systems Management Server 84

T
transforms
  chain installations 76
  configure shortcuts 78
  creating 75
  select features 77

U
uninstalling 25
unlock domain  56
upgrade and migration  17
user
  adding  55
user accounts  55
  adding  55

X
X Manager
  interface  31
XDMCP
  getting started  27
XIM server
  defined  104